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法律资讯前言 

手册的主题 

SIMATIC PCS 7 是一个非常开放的系统，可以灵活适应各种各样的客户需求。 该系统软

件在项目组态以及程序和可视化设计方面给项目工程师提供了很大的自由度。 

经验表明，如果从一开始就尽量“按照 PCS 7 的标准”来组态项目，则后续的现代化与工厂

扩展工作会变得更加容易。 这意味着必须完全遵守某些基本规则，才能确保所提供的系

统功能在将来发挥最大的作用。 

除作为介绍 SIMATIC PCS 7 的产品文档外，本手册还用作提纲。本手册以大量图解介绍

了创建和组态项目的基本任务。 

本提纲直接提出了建议的组态方法，这是基于大量实践经验结果而得到的。 本说明并不

涵盖应用本身；而是涉及项目的处理及其所包含元件的参数设置。 

本提纲分为三部分： 

● A 部分： 组态准则 

● B 部分： 过程安全 

● C 部分： 使用 SFC 类型的工艺功能 

有效性 

考虑到其与 PCS 7 V6.1 SP1 及更高版本间的区别，该组态准则对 PCS 7 V7.0 SP1 及更

高版本有效。 



SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则  
  

 提纲 A 部分 - 组态准则 
4 操作手册, 09/2009, A5E02122388-01 

更多支持 

如果对如何使用本手册中描述的产品有任何疑问，而本文未给出解答，请与您当地西门子

代理联系。 

可在以下网址找到联系信息：  
(http://www.siemens.com/automation/partner) 

您可以通过以下网址找到为各 SIMATIC 产品和系统提供的技术文档指南： 
(http://www.siemens.de/simatic-tech-doku-portal) 

在线目录和在线订购系统位于：  
(http://mall.automation.siemens.com/) 

培训中心 

西门子提供了大量培训课程，以帮助您熟悉 SIMATIC PCS 7 过程控制系统。 请联系区域

培训中心或德国纽伦堡 90327 (http://www.sitrain.com) 的培训中心总部。  

技术支持 

您可使用支持请求 Web 表单联系所有工业自动化与驱动技术产品的技术支持： 
(http://www.siemens.de/automation/support-request) 

Internet 上提供了有关技术支持服务的更多信息，网址为： 
(http://www.siemens.de/automation/service) 

Internet 上的服务和支持 

除了文档外，我们还在线 (http://www.siemens.com/automation/service&support)为您提

供了我们的专业技术。  

在这您可以访问： 

● 新闻快讯，不断提供有关我们的产品的最新信息 

● 您所需的文档，可通过“服务与支持”门户中的搜索工具进行搜索 

● 论坛，为用户和专家提供一个用于交流经验的国际平台 

● 工业自动化与驱动技术的当地联系伙伴 

● 关于本地服务、维修、备件的信息。“服务”部分提供了更多选项。 

http://www.siemens.com/automation/partner
http://www.siemens.de/simatic-tech-doku-portal
http://mall.automation.siemens.com/
http://www.sitrain.com/
http://www.siemens.de/automation/support-request
http://www.siemens.de/automation/service
http://www.siemens.com/automation/service&support
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PC 管理 1
1.1 安装 

SIMATIC PCS 7 工业工作站 (IPC) 上预安装了操作系统和 SIMATIC PCS 7 软件。 
 

 说明 
如果要执行手动安装，请遵循文件“PCS 7 自述文件”以及《过程控制系统 PCS 7；PC 组
态与授权》手册中的相关要求和步骤。 

 

计算机命名规则 

视语言和组件而定，名称中仅允许某些字符。 ASCII 字符集中的所有字符都可用于 OS。 
最好不要使用国家的特殊字符。 

计算机名称的选择对整个项目的组态很重要： 

● 非法字符：. , ; : ! ? " ' ^ ´ ` ~ - + = / \ ¦ @ * # $ % & § ° ( ) [ ] { } < > 空格 

● 最多 15 个字符 

● 只能使用大写字母 

● 第一个字符必须为字母。 

强烈建议计算机名称只使用字母数字字符。 您选择的名称只能由大写字母和数字组成，

并且以字母开头，最多包含 15 个字符。 
 

 说明 
有关项目的其它命名约定，请参见： 

• 手册《过程控制系统 PCS 7；工程系统》(Process Control System PCS 7 
Engineering System) 

• WinCC 在线帮助，输入字符串“非法字符”(illegal characters) 进行搜索 

• C:\Program Files\SIEMENS\WINCC\Documents\English\Projects.pdf 
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更改计算机名称 

在安装完 PCS 7 并首次打开 WinCC 项目管理器之后，便不能更改计算机名称。 如果确

实想要更改计算机名称，则必须再次安装计算机（恢复 DVD）。 经验表明，更改计算机

名称通常会引起（网络、通信等方面的）问题。 因此，请务必遵循以下规则： 

● 安装 Windows 和 SQL 服务器后，请勿更改计算机名称。 

● 如果想要更改 PC 组件包的计算机名称，请使用恢复 DVD 执行重新安装 

● 如果想要更改独立安装 PC 的计算机名称，请重新安装 Windows。 
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1.2 工作组和域 

工作环境 

用户必须决定是在工作组环境还是在域环境中运行 PCS 7 工厂的计算机。 

下表对这两个不同的环境进行了比较，指出了各自优点和缺点（从纯技术角度来看）；同

时还假定了一些（实例）方案，并说明如何在工作组和域中完成相关操作。 
 

 说明 
可以以这些信息为基础做出决策，也可以依据这些信息进行相关讨论。 除了技术标准

外，还必须考虑组织因素，如客户特定的 IT 系统、Microsoft 知识基础、资源、支出和维

护等。 
 

常规信息、优点和缺点 

 

 域（AD；活动目录） 工作组 (WG) 

如果要集中保存用户信息 如果在整个网络中不需要用户设置 

中央安全数据库 本地安全数据库 

提供可扩展性（可构建非常大型的网络） 用于严密封闭站点上的有限数量的计算机 

常规信息 
（与 Microsoft 
Windows 相
关） 

在 AD 中管理设备和文件的权限。 由各个计算机单独管理设备和文件的权限。 

缺点： 

管理员需要具备广博的知识（此环境比工

作组环境对人员水平的要求高很多）。 

优点： 

管理员不需要处理 AD，但应熟悉设置和管理

网络中的 WG 计算机。 

优点： 

在 AD 中集中管理用户帐户、资源（安全

方面）和分组原则。 

缺点： 

分散到每台计算机上分别管理用户帐户、资

源（安全方面）和分组原则。 

缺点： 

需要另外的计算机来管理 AD。 

优点： 

不需要 Windows 服务器计算机来保存中央安

全信息（除非使用基础架构计算机，如 
DHCP 服务器）。 

优点和缺点 

缺点：需要进行更广泛的规划 优点：不需要太多规划 

与 SIMATIC 
Logon 结合使用 

利用已设置的 AD 用户。 可以在中央工作站上编辑用户。 
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方案 

 

方案（实例） 域（AD；活动目录） 工作组 (WG) 

在 AD 中集中创建 必须在每一台计算机上添加 添加新用户 

可以立即应用于所有计算机 必须在每一台计算机上更改 

更改用户密码 在 AD 中集中创建 必须在每一台计算机上更改 

添加/更换计算机 按照相应组织单位的分组原

则自动应用设置。 
必须在各计算机上本地进行设

置。 

必须更改安全设置。 在 AD 中集中更改，然后通

过分组原则分配更改 
必须本地进行所有更改。 

分布式 Microsoft 更新 通过 Microsoft Windows 软件更新服务 (WSUS) 

通过 AD 显示设备 不显示设备。 
必须清楚设备的连接信息。 

添加打印机/传真机/扫描

仪等 

可以集中设定每台设备的安

全设置。 
想要使用设备，用户必须本地

存在于此计算机，并且必须使

用本地用户信息登录。 

可以集中保存用户配置文

件。 

这意味着，登录期间会将设

置传送到所有计算机。 

用户在每台计算机上有一个本

地配置文件。 
用户使用多台计算机 

如果不集中保存配置文件，

则每位用户将有自己的本地

配置文件。 

 

上述列表并没有区分重要性；用户必须自行确定哪些优点或缺点对于相关的 PCS 7 工厂

最重要。 

域实例 

在域结构中可以集中进行更改显然是一种用户友好的功能。 但是，域管理的成败取决于

掌握的专业知识和提供的支持以及投入的工作强度，并且在实际建立相应系统时域管理还

会涉及一些额外支出。 而这又不可避免需要进一步培训操作人员。 
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工作组实例 

在工作组中，需要在本地计算机上进行大部分设置。 但是，如果 PCS 7 工厂使用相对固

定的设置运行，而且预计只需进行少量更改，则这些设置只需设置一次。 因此使用工作

组时，不需要考虑花费在创建域上的时间，不需要随后提供额外培训。 
 

 说明 
更多相关信息，请参考《PCS 7 安全性概念》(PCS 7 Security Concept)手册中“管理计算

机和用户”部分。 (http://support.automation.siemens.com/WW/view/en/22229786) 
 

http://support.automation.siemens.com/WW/view/en/22229786
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1.3 网络设置 

地址管理 

安装完成后，检查地址并进行所有必要的设置。 在项目开始时进行系统性分配可以简化

组态、调试、工厂扩展和维护过程。 

例如，将已分配的地址记录在如下所示的表中，并及时更新。 

 

名称 
子项目 

名称 
PC 站/ 
AS 站 

终端总线 
IP 地址 

工厂总线 
IP 地址 

工厂总线 
CP1613 MAC 地址 

工厂总线 
CP443-1 
MAC 地址 

25_ES ES26 172.20.1.26 172.10.1.26 08-00-06-01-00-26 X 

20_OS SERVER1A 172.20.1.xx 172.10.1.xx 08-00-06-01-00-xx X 

20_OS SERVER1B 172.20.1.xx 172.10.1.xx 08-00-06-01-00-xx X 

21_CL CLIENT01 172.20.1.xx X X X 

21_CL CLIENT02 172.20.1.xx X X X 

21_CL CLIENT03 172.20.1.xx X X X 

21_CL CLIENT04 172.20.1.xx X X X 

01_Plant_A AS1_H X X X 08-00-06-01-01-10 

01_Plant_A AS1_H X X X 08-00-06-01-01-11 

02_Plant_B AS2 X X X 08-00-06-01-01-26 

 Scalance20 172.20.1.xx X X X 

 Scalance10 X 172.10.1.xx X X 
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设置网络的传输速率和工作模式 

西门子设备，包括工业以太网交换机（OSM/ESM、ScalanceX）和工业以太网 CP（CP 
443-1，从版本 1EX10 开始），出厂时已设置为自动检测传输速率以及工作模式参数（自

动检测、自动协商）。 

自动检测是指网络组件自动解释进入传输信号的属性。 在这种情况下，设备独立确定信

号的数据传输率是 10 Mbps、100 Mbps 还是 1,000 Mbps。 换句话说，不必明确进行设

置来规定设备以高速以太网还是标准以太网运行。 

自动协商是指高速以太网的组态协议。 自动协商使所有相关设备都能够在发送数据包之

前协商传输规则。 传输速率为 10 或 100 Mbps，并且通过协商确定传输方法。 传输方法

选项有半双工或全双工。 

从 PCS 7 V6.1 开始适用以下规则： 

保持出厂设置。 
 

 说明 
仅当工厂总线或终端总线上的其中一个组件不支持自动协商功能时，用户才需要将插接电

缆上的两个组件手动设置为统一的传输设置，例如 100 Mbps 全双工。 不一致的设置可

能导致不可预知的故障情况。 
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1.3.1 组态终端总线 

步骤 

1. 重命名“终端总线”(Terminal bus) 连接。 

要确保通过终端总线在所有节点（OS 服务器、OS 客户机等）上实现无故障通信，必

须依照访问网络服务的顺序首先找到相关的网卡。 在“高级 -> 高级设置...”(Advanced 
-> Advanced Settings...) 下进行此设置；请见下面的屏幕截图。 
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2. 按以下方式分配连接参数（实例设置）： 

– 使用 TCP/IP 

– 分配 IP 地址（此处为 172.20.1.26） 

– 分配子网掩码（此处为 255.255.0.0 - B 类网络） 

 

如果使用 DNS 服务器，还需要输入该服务器的 IP 地址，并在“高级...”(Advanced...) 
下激活 WINS 服务。 
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3. 如果不使用域结构，则创建“PCS 7”工作组。 

  说明 
设置、管理和备份网络结构（如工作组和域）是一个复杂的话题。 
有关此主题的相应建议和信息，请参见手册《PCS 7 安全性概念；建议和注意事项》

(PCS 7 Security Concept Recommendations and Notes)（适用于 PCS 7 V6.1）： 
(http://support.automation.siemens.com/WW/view/en/22229786) 
和《PCS 7 和 WinCC 安全性概念 – 基本文档》(Security Concept PCS 7 and WinCC 
– Basic Document)（适用于 PCS 7 V7.0）： 
(http://support.automation.siemens.com/WW/view/en/26462131) 

检查通信伙伴的可用性 

完成终端总线的网络设置后，可以使用每个工作站上的 SIMATIC Shell 工具检查终端总线

上是否有所需伙伴站（ES、OS 服务器和 OS 客户机）。SIMATIC Shell 以 Windows 资
源管理器工作区中的一个文件夹形式提供。 

 

如果在 SIMATIC Shell 中没有所需伙伴站，则可能表示 TCP/IP 名称解析设置不当。 对
于 TCP/IP 网络的这个方面，存在几个相关概念，首先是编辑 LMHOSTS 和 HOSTS 文
件，接着是使用 WINS/DNS 服务器（另请参见 FAQ： 
(http://support.automation.siemens.com/DE/view/en/868014)）。 

http://support.automation.siemens.com/WW/view/en/22229786
http://support.automation.siemens.com/WW/view/en/26462131
http://support.automation.siemens.com/DE/view/en/868014
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可以使用快捷菜单中的“设置...”(Settings...) 触发 SIMATIC Shell 的刷新。 选择终端总线

的网络适配器并单击“确定”(OK)。 
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1.3.2 组态工厂总线 

PCS 7 ES 如何通过工厂总线通信？ 

 

在 SIMATIC PCS 7 中，必须将“S7 在线”(S7 online) 访问点设置为“PC 内部”(PC internal) 
接口。 对 AS 进行的所有访问（例如，为了检查 AS 的模块信息或为了下载 S7 程序）都

通过“PC 内部”(PC internal) 执行。 “PC 内部”(PC internal) 是一个可集中组态的接口，可

在该接口中加载工厂总线上所有工作站的项目特定设置。在 ES 上的 PCS 7 多项目中进

行设置，然后从 ES 下载这些设置。 您可在工程师站 (页 44)部分找到相关步骤说明。 

只要激活“PC 内部”(PC internal)，网络适配器即开始在“已组态模式”(configured mode) 下
工作，否则在“PG 模式”(PG mode) 下工作。 
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步骤 

1. 在工厂总线的高级设置中，禁用工厂总线绑定（Windows 通信的复选标记）。 
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2. 检查已安装网络适配器的当前组态，使用“组态控制台”(Configuration Console) 工具

（“开始 > SIMATIC > SIMATIC NET > 设置 PC 站”(Start > SIMATIC > SIMATIC NET 
> Set PC Station)）中进行可选设置。 

 

以下设置是特定于 PCS 7 的设置： 

– 激活“已组态模式”。 

– 将访问点设置为“内部 PC”(PC internal)。 

– “仅激活 ISO 协议”（如果只想使用 ISO 协议，不想使用  
TCP/IP） 

– 分配 MAC 地址（仅在“PG 模式”下可行）。 
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 说明 
何时在工厂总线上使用 TCP/IP？ 

• 工厂总线和终端总线在一条总线上 

• 需要通过子网路由 

• 使用集成有以太网接口的自动化系统 

• 使用 NTP（Network Time Protocol，网络时间协议）进行时间同步 

• 为了进行资产管理而监视工厂总线上的网络组件 

• 在工厂总线上运行网关（AS 的外部连接） 
何时在工厂总线上使用 ISO 协议？ 

• 只有使用 H 机器（S7 容错）时，才可使用 ISO 

• 时间同步基于 SIMATIC 过程 
 

 

CP1613 的优点 

在工程师站/OS 服务器上使用 CP 1613 有以下优点： 

● 可连接超过 8 个 AS。 

● 可以组态容错连接。 
（H 机器，自动通信切换） 

● “OS 仿真”功能也可用于冗余自动化系统。 

● 可分配或修改 CP 1613 的 MAC 地址参数。 

  说明 
如果使用 BCE（Basic Communication Ethernet，基本通信以太网）模块而非 CP 
1613 进行通信，则 MAC 地址是固定的，无法为其分配参数。 这意味着，在出现错误

（故障模块）时，必须使用替换模块的新 MAC 地址重新组态连接，并需要相应修改项

目文档。 
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创建和管理 PCS 7 项目 2
 

本部分介绍如何在工程师站 (ES, Engineering Station) 上创建 PCS 7 项目。 它是基于以

下硬件体系结构实例进行介绍的： 

 

 

 

● 2 个自动化系统（AS 417-4 和 AS 417-4H） 

● 1 个工程师站 (ES) 

● 1 个 OS 服务器，使用冗余 OS 服务器作为伙伴站 

● 4 个 OS 客户机 
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2.1 通用组态规则 
在创建自己的 PCS 7 项目之前，应该熟悉这些重要规则。 这有助于您避免花两倍努力来

执行某些任务。 

集中组态 

通常必须先在 PCS 7 系统中的 ES 上执行整个组态，然后再将 OS 项目加载到相应的 PC 
上。 

必须在 OS 服务器上执行以下任务： 

● 激活时间同步。 
如果 ES 无权访问 CP 1613，则必须在各服务器上进行激活。 

● 检查/验证各 OS 服务器的冗余设置。 
使用 PCS 7 V7.0 或早期版本时，必须在冗余对话框中单击“确定”(OK)，在计算机上

本地保存有关用于冗余监视的接口（COM1/COM2 或附加网络适配器）信息。 
从 PCS 7 V7.0 SP1 开始，可以在每个 OS 服务器上通过 SIMATIC Shell 的对象属性

本地设置冗余接口。 
 

 说明 
有关跨多个工程师站分布组态工作的信息，请参考 分摊组态工作 (页 73)部分。 

 

OS 仿真 

不要在工程师站上激活 OS 项目，请在 OS 上激活项目（此选项从 PCS 7 V7.0 开始被锁

定）。 使用“OS 仿真”可以独立于客户机执行测试。 

● 为此，选择要仿真的 OS，然后单击“启动 OS 仿真”(Start OS Simulation) 启动运行系

统。 此命令将在运行系统启动之前自动创建 OS 项目的副本以进行测试，并禁用副本

中的冗余。 这可确保运行数据库受到保护并保持原始状态。 

● 在线访问需要在 NetPro 中组态 ES 和 AS 之间的连接（请参见 ES/AS 连接 (页 139)
部分）。 

● 如果是 OS 服务器项目，还会出现一条消息，指出 WinCC 服务器授权丢失。 为了继

续在 ES 上测试，请确认此消息或将其移到背景中。 

● 下次启动仿真时，将更新临时目录中的数据。 

● 当 OS 处于仿真模式时，无法对其上的组态数据进行任何更改。 
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备份 

不要忘记定期对整个项目（或多项目）进行备份，尤其在该项目由多个人员进行编辑时更

应如此。 在执行工程期间，应该每天创建一次备份。 

主数据库 

使用项目主数据库，确保编辑项目的所有人员使用该库中的块和模板。 

时间同步 

时间同步对于中断和变量记录系统极其重要。 确保在运行系统中只有一个（冗余）时间

服务器处于激活状态，且所有工作站（PC 和 CPU）都使用正确的时间。 在 PCS 7 V7.0 
中，CPU 始终使用协调世界时 (UTC, Coordinated Universal Time)。 

有关时间同步的信息，请参见： 

● 手册《PCS 7 时间同步》(PCS 7 Time Synchronization) 
(http://support.automation.siemens.com/DE/view/de/28518882/0/zh)  

● 《PCS 7 - 组态手册 - 操作员站》(PCS 7 - Configuration Manual - Operator Station) 
中的“设置时间同步”部分 

● 《PCS 7 - 功能手册 - PCS 7 V7.0 高精度时间戳》 
(PCS 7 - Function Manual - PCS 7 V7.0 High-Precision Time Stamping) 

● 《PCS 7 - 功能手册 - PCS 7 V6.1 10 毫秒时间戳》 
(PCS 7 - Function Manual - PCS 7 V6.1 10 ms Time Stamping) 

http://support.automation.siemens.com/DE/view/de/28518882/0/zh
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特殊字符 

PCS 7 工程中的非法字符： 

 

组件 非法字符 

层级文件夹 . " / \ % 

WinCC 项目名称 . , ; : ! ? " ' + = / \ @ * % [ ] { } < > 空格 

AS/OS 连接名称 . : ? " ' \ * % 空格 

编译 OS 时，名称中的 [ ‘ ] [ . ] [ % ] [ \ ] [ * ] [ ? ] [ : ] [空格] 字符会转换为替代字符 [ $ ]。
ES 分隔符 [\] 将转换为 [/] 字符。 

 

 说明 
例如，如果为 CFC 图表分配了名称“TICA:1”（此名称在 OS 上将变成“TICA$1”），同时

为另一个 CFC 图表分配了名称“TICA*1”（此名称也将变成“TICA$1”），在对第二个图表

执行 OS 编译时将收到一条错误消息，原因是该图表名称已存在。 
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2.2 SIMATIC Manager 中的必需设置 

简介 

在创建多项目之前，应检查 SIMATIC Manager 的默认设置，并进行调整以适应用户要

求。 

为此，在 SIMATIC Manager 中，转到“选项 > 设置...”(Options > Settings...)。 

每个对话框中都有在线帮助，提供可选设置的准确说明。 下面还列出了可使组态工作更

容易的一些实用设置。 

常规 

将项目/多项目的存储位置设置为数据分区中的一个目录。 

语言 

关于助记符，必须要决定对于要创建的多项目的 I/O 地址是使用德语还是英语助记符。 

归档 

PKZip 用于归档多项目。 为了简化归档过程，还需要在“组态”(Configure) 对话框中将“跨
磁盘归档”(Archive spanning diskettes) 选项设置为“否”(No)。 

PKZip 4.0 会检查输入的文件名是否能适用于归档。 

消息号 

从 PCS 7 V6.1 开始，应设置“分配面向 CPU 的唯一消息编号”(Assign CPU-oriented 
unique message numbers) 复选框。 这可确保复制 S7 程序时不需要更改消息号。 
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2.3 自动创建多项目 

简介 

开始工作前，定义一个用于保存所有 PCS 7 项目的目录。为确保数据完整性，应分别保

存系统数据和项目数据。 我们建议在一个单独的目录中使用数据分区。 

使用“新建项目”(New Project) 向导创建多项目。 此向导会自动创建所需的项目结构，从

而用户可以立即开始对工厂进行实际的工程组态。 

拆分多项目 

我们的实例项目“Comp_MP”包含以下几个部分： 

● ES 的子项目“25_ES” 

● 冗余 OS 服务器对的子项目“20_OS” 

● OS 客户机的子项目“21_CL” 

● 容错 AS 的子项目“01_PLANT_A” 

● 标准 AS 的子项目“02_PLANT_B” 

● 主数据库“Comp_Lib” 

用户可通过工艺条件和本地情况以及项目规范（如项目工程师数量或责任分配等）来确定

如何将多项目分成各种子项目。 
 

 说明 
通常，我们建议基于工作站组织 PCS 7 中的多项目，即每个工作站一个子项目。 按照这

种方式设置可在组态/调试阶段获得最大的灵活性。 
这适用于所有自动化系统和 OS 服务器。 还可以在子项目中为 OS 客户机创建工作站。 
以下规则适用于 PCS 7 V7.0： 
必须在与参考站相同的子项目中创建被参考站。 
您可从下列链接找到有关分布式工程组态的详细信息： 
(http://support.automation.siemens.com/WW/view/en/22258951) 

 

参见 

使用 PCS 7 V7.0 创建多项目 (页 31) 

使用 PCS 7 V6.1 创建多项目 (页 36) 

http://support.automation.siemens.com/WW/view/en/22258951
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2.3.1 使用 PCS 7 V7.0 创建多项目 

创建多项目 

1. 在 SIMATIC Manager 中，选择“文件 > 新建项目向导”(File > New Project Wizard)，
以创建一个新的多项目。 

2. 在出现的第二个窗口中，选择 417 H 系统。 
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3. 在第三个窗口中，禁用所有 OS 对象。 在本指南稍后所述的一个步骤中创建此项目组

件。 
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4. 在第四个窗口中，更改项目名称和存储位置（如果适用），本例中为“Comp”和
“D:\PCS7_Project”，然后单击“完成”(Finish) 确认选择。 

 

5. 将使用 H 系统的工厂 A 的项目名称更改为“01_Plant_A”（Plant_A 为工厂的名称）。 
在组件视图中，选择“Comp_Prj”项目文件夹，按 F2，重命名该对象。 
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6. 将“SIMATIC H station (1)”重命名为“AS1_H”。 

  说明 
可自由分配多项目和子项目的项目名称。 PCS 7 会在 Windows 级自动创建数据存储

路径。 路径名称可与项目名称不同（缩短到八个字符）。 由于 PCS 7 数据只能在 
SIMATIC Manager 中编辑，所以此路径名称对用户无关紧要。 

集成附加的 AS 子项目 

1. 为工厂 B 创建新项目。该项目在稍后将包含一个标准 CPU。 

2. 将名称改为“02_Plant_B”（Plant_B 为该工厂的名称）。如果可以，请顺便更改存储位

置。 

 



 创建和管理 PCS 7 项目 
 2.3 自动创建多项目 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 35 

设置显示设备的语言 

必须检查多项目中所有子项目的显示设备的语言设置。 用户必须在此设置工程中和 OS 
上使用的所有语言。 必须在首次编译包含 OS 服务器的子项目之前完成，这样才能以 OS 
上的所有语言创建文本。 

要检查设置，请选择相应的子项目，然后选择菜单命令“选项 > 显示设备的语言”(Options 
> Language for Display Devices)。 
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2.3.2 使用 PCS 7 V6.1 创建多项目 

创建多项目 

 

1. 在 SIMATIC Manager 中，选择“文件 > 新建项目向导”(File > New Project Wizard)，
以创建一个新的多项目。 

2. 选择类型“多项目…”(Multiproject…)。 

 

3. 在出现的第二个窗口中，选择 417 H 系统。 
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4. 在第三个窗口中，禁用所有 OS 对象。将在本指南稍后所述的一个步骤中手动创建此

项目组件。 

 

5. 更改项目名称和存储位置（如果适用），本例中为“Comp”和“D:\PCS7_Project”，然后

单击“完成”(Finish) 确认选择。 

 



创建和管理 PCS 7 项目  
2.3 自动创建多项目 

 SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
38 操作手册, 09/2009, A5E02122388-01 

6. 将使用 H 系统的工厂 A 的项目名称更改为“01_Plant_A”（Plant_A 为工厂的名称）。 
在组件视图中，选择“Comp_Prj”项目文件夹，按 F2，重命名该对象。 

 

7. 以相同方式将“SIMATIC H station (1)”重命名为“AS1_H”。 

集成附加的 AS 子项目 

1. 在 SIMATIC Manager 中，选择“文件 > 向导 > 新建项目”(File > Wizard > New 
Project)，以创建新的单项目。 

2. 选择类型“单项目…”(Single project…)。 
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3. 在向导的“步骤 2”中，选择一个标准自动化系统（在本例中为 CPU 417）。 

4. 在“步骤 3”中，禁用所有 OS 对象。将在本指南稍后所述的一个步骤中手动创建此项目

组件。 

5. 在“步骤 4”中，将名称更改为“02_Plant_B”，将存储位置更改为 
D:\PCS7_Project\Comp_MP。 单击“完成”(Finish) 确认输入。 

6. 现在需要将所创建的子项目插入到多项目中。 为此，选择多项目，单击菜单命令“文件 
> 多项目 > 插入多项目...”(File > Multiproject > Insert into Multiproject...)，并选择创建

的子项目。 

设置显示设备的语言 

必须检查多项目中所有子项目的显示设备的语言设置。 在此处设置工程组态中和操作员

站上要使用的所有语言。 必须在首次编译包含 OS 服务器的子项目之前完成，这样才能

以 OS 上的所有语言创建文本。 

要检查设置，请选择相应的子项目，然后选择菜单命令“选项 > 显示设备的语言”(Options 
> Language for Display Devices)。 
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2.4 集成附加的 ES/OS 子项目 

要求 

在集成新项目之前，在 SIMATIC Manager 中选择多项目。 

步骤 

1. 为 OS 服务器和冗余 OS 伙伴服务器创建一个新项目。 将名称改为“20_OS”；同时也

更改存储位置。 

 



 创建和管理 PCS 7 项目 
 2.4 集成附加的 ES/OS 子项目 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 41 

2. 为所有 OS 客户机创建一个新项目。 将名称改为“21_CL”；同时也更改存储位置。 

 

3. 为 ES 创建一个新项目。 将名称改为“25_ES”；同时也更改存储位置。 
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4. “新建项目”(New Project) 向导已生成了主数据库，并将其添加到项目中。 系统会将它

保存到“D”盘的项目文件夹中。 “Comp_Lib”库会包含项目中使用的所有块和模板。 

  说明 
一些重要的 PCS 7 功能会要求数据集中存储在主数据库中，如导入/导出助手，将块自

动导入多项目中的所有 S7 程序等功能。  
主数据库还可确保所有项目工程师使用同一个数据库。 此设置方便了工程阶段的协调

和组织，以及后续的项目扩展/升级。 

执行了所有步骤后，在组件视图中将显示相应的结构。 
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2.5 安排组件 
项目创建完成后，必须根据工厂的硬件配置来配备自动化系统 (AS) 和 PC 站。 

 

 说明 
不配置终端总线的网络适配器。 

 

下面提供了一个项目结构实例： 
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2.5.1 工程师站 

必须根据 PC 的硬件来组态“SIMATIC PC 站”对象。 

步骤 

1. 在项目“25_ES”中插入 SIMATIC PC 站。 为此，选择项目，然后选择快捷菜单命令“插
入新对象 > SIMATIC PC 站”(Insert New Object > SIMATIC PC Station)。 

2. 重命名 PC 站。 

我们建议使用 ES 的 Windows 计算机名称（例如“ES22”）。 这适用于所有 PC 站。 
PC 站的名称必须与站组态编辑器（其中已有预设的计算机名称）中的站名称匹配。 

随后在 SIMATIC Manager 中的 PC 站图标上会出现一个黄色箭头，指示该 ES 能够

通过“PC 内部”(PC internal) 接口建立与工厂总线的连接。 
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3. 在 PC 站的对象属性中激活“计算机名称与 PC 站名称相同”(Computer name identical 
to PC station name) 选项，不管“计算机名称”(Computer name) 域是可编辑还是灰

显，都必须已填写，因为其它功能（如“组态 PC 站”）会引用此信息。 

 

  说明 
重命名 PC 站，使其名称与计算机名称匹配。 为此，可以激活“计算机名称与 PC 站名

称相同”(Computer name identical to PC station name) 选项，这意味着不必进行过多

输入，因此可减少输入错误的可能性。 

  说明 
使用资产管理时，将不会为 ES 的 PC 站（黄色箭头）输入计算机名称。 有关详细信

息，请参考“集成资产管理”部分。 

4. 打开 PC 站的 HW Config。 
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5. 插入“WinCC 应用程序”，以便以后可在该 ES 上测试 OS 功能。 
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6. 插入 CP 1613，以执行与工厂总线通信。 
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7. 在 CP 1613 的对象属性中为工厂总线创建新子网，并将预定的 MAC 地址分配给 CP 
1613。 
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8. 在 CP1613 属性对话框的“选项”(Options) 选项卡中，激活“日时钟模式”(Time-of-day 
mode)，这样 CP1613 基本上能转发时间帧。 

 

9. 最后，使用功能“PLC > 组态...”(PLC > Configure...) 将硬件配置传送到 ES（站组态编

辑器），如以下屏幕截图所示。 

 

组态成功完成后，两个已组态组件的状态和工作模式会显示在站组态编辑器中，如以

下屏幕截图所示。 
 

10. 现在，使用功能“PLC > 下载”(PLC > Download) 加载“ES 站组态编辑器”（见以上屏幕

截图）。 
下载完成后，检查所有组件是否处于 RUN 模式。 
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2.5.2 自动化系统 - 容错 

使用 PCS 7 V7.0 时的步骤 

1. 在两个 CP 443-5 Ext 设备的属性中，检查“工作模式”(Operating Mode) 选项卡上的

“DP 主站”(DP Master) 是否设置为“DPV1”DP 模式；可根据需要更改这些参数。 

2. 将分布式工作站（如 ET 200M）连接到冗余 DP 主站系统。 
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3. 在两个 CP 443-1 设备的属性中，设置预定的 MAC 地址，并将已创建的子网分配给工

厂总线。 

  说明 
我们建议您为不同 SIMATIC 站的 S7 项目文件夹分配唯一的名称，以避免混淆。 S7 
程序名称不可包含空格。 

 

使用 PCS 7 V6.1 时的步骤 

1. 将一个 CP 443-1 和一个 CP 443-5 Ext 插入到 Rack0 和 Rack1 中。 

2. 为两个 CP 443-5 Ext 设备创建新的 DP 主站系统（请参见 STEP 7 帮助“创建 DP 主站

系统”）。 

3. 在两个 CP 443-5 Ext 设备的属性中，检查“工作模式”(Operating Mode) 选项卡上的

“DP 主站”(DP Master) 是否设置为“DPV1”DP 模式。 

4. 将分布式工作站（如 ET 200M）连接到冗余 DP 主站系统。 

5. 在两个 CP 443-1 设备的属性中，设置预定的 MAC 地址，并将已创建的子网分配给工

厂总线。 

  说明 
我们建议您为不同 SIMATIC 站的 S7 项目文件夹分配唯一的名称，以避免混淆。 S7 
程序名称不可包含空格。 
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2.5.3 自动化系统 - 标准 

使用 PCS 7 V7.0 时的步骤 

1. 将包括 CP 的预组态 AS 插入“02_Plant_B”子项目。 

 

2. 在 CP 443-5 Ext 的属性下，在“工作模式”(Operating Mode) 选项卡中设置“DP 主
站”(DP master)（DPV1 DP 模式）。 
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3. 连接 ET 200M 站。 

 
 

 说明 
使用命令“激活 CiR 功能”(Enable CiR Capability) 后可以在图中所示的总线上看到 CiR 对
象。 在“运行中组态 (CiR)”部分对该主题进行了更详细地说明。 

 

 

使用 PCS 7 V6.1 时的步骤 

1. 插入 CP 443-1 和 CP 443-5 Ext。 

2. 为 CP 443-5 Ext 创建新的 DP 主站系统（请参见 STEP 7 帮助“创建 DP 主站系

统”）。 
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3. 在 CP 443-5 Ext 的属性下，在“工作模式”(Operating Mode) 选项卡中，将“DP 主
站”(DP master) 设置为“DPV1”DP 模式。 

4. 连接 ET 200M 站。 

 
 

 说明 
使用命令“激活 CiR 功能”(Enable CiR Capability) 后可以在图中所示的总线上看到 CiR 对
象。 在“运行中组态 (CiR)”部分对该主题进行了更详细地说明。 

 

2.5.4 OS 服务器 

步骤 

1. 在 OS 项目中创建一个新的 PC 站，并在 HW Config 中打开该站。 

2. 在一个空行中为“SERVER1A”插入“WinCC 应用程序”(WinCC Application) 对象。 

3. 另外在空行中将 CP 1613 组态为工厂总线的网络适配器。 
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4. 使用唯一的 MAC 地址并分配现有子网。 
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5. 在 CP 1613 属性对话框的“选项”(Options) 选项卡上，分配时间同步参数。 

 

6. 在 HW Config 中，对“SERVER1B”备用服务器使用“WinCC 应用程序（备

用）”(WinCC application (stby)) 对象，并将预定的 MAC 地址用于 CP 1613 适配器。 
其余信息与“SERVER1A”的组态信息相同。 
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7. 重命名 OS 对象“OS1”。 
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8. 在“SERVER1A”OS 的属性对话框中，打开“目标 OS 和备用 OS 计算机”(Target OS 
and Standby OS Computer) 选项卡。 

– 在此输入目标 OS 计算机的路径。 

在目标 OS 上必须提供具有写入权限的共享文件夹。 

– 输入一个有意义的名称作为符号计算机名称。 

符号计算机名称决定了服务器前缀，进而决定了服务器数据。 它是 OS 服务器/客
户机通信的决定性因素。 此处应避免使用国家的特殊字符。 
只能在初始组态期间进行该设置。 

– 选择备用 OS 作为冗余服务器，如本例中所示。 

– 根据需要激活“换出到中央归档服务器”(Swap out to central archive server) 选项。 

 

9. 单击“确定”(OK) 合并 SERVER1A 和 SERVER1B 中的两个 OS 项目，以构成一个冗

余 OS 项目。 SERVER1B 中之前的 OS 项目名称将自动重命名为“OS1_StBy”。 所有

过程画面将只分配到 SERVER1A 的 OS 项目“OS1”。 
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10. 接着，打开所分配的备用 OS 的属性对话框，并在此处为相应的目标 OS 计算机输入

路径。 
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11. 将该 PC 站的组态从 SIMATIC Manager 传送到两个 OS 服务器。 重复执行用于 ES 
的步骤： 
首先调用功能“PLC > 组态...”(PLC > Configure...)，然后调用“PLC > 下载...”(PLC > 
Download...)。 

下图显示了该工厂总线的组态，其中所有任务均从中央 ES 执行。 
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2.5.5 OS 客户机 

常规步骤 

1. 在 PC 站的 HW Config 中组态“WinCC 应用程序客户机”。 

 

2. 在 SIMATIC Manager 中，将 OS 客户机项目重命名为“CL01”。 
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3. 在对象属性中输入目标 OS 的路径。 

在目标 OS 上必须提供具有写入权限的共享文件夹。 

 

在 PCS 7 V6.1 中，以此方法创建和组态所有 PCS 7 OS 客户机。 若使用 PCS 7 V7.0，
您还可以使用参考客户机，如下所述。 
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在 PCS 7 V7.0 中使用 OS 参考客户机 

在多个 OS 客户机上的所有设置都相同时，总是会使用 OS 参考客户机。 每个 OS 客户

机均可用作其它客户机的基础（“WinCC 应用程序参考”）。 

1. 将一个 PC 站组态为“WinCC 应用程序客户机参考”(WinCC Appl. Client Ref)，以满足

相同客户机的数量。 

 

2. 在“WinCC 应用程序客户机参考”(WinCC Appl. Client Ref) 内创建的 OS 项目的对象属

性中，组态“OS 基础”(OS Basis) 和“OS 目标计算机的路径”(Path to the OS target 
computer)。 

在目标 OS 上必须提供具有写入权限的共享文件夹。 
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3. 您可以在现有 OS 客户机项目的“OS 基础”(OS Basis) 域中寻找合适项。 

 

在本例中，CLIENT02 与 CLIENT01 相同。 OS 客户机项目参考 CLIENT01 中的 OS 客
户机项目。 但是，在 CLIENT02 上设置目标 OS 计算机路径。 

 

 说明 
如果参考客户机的设置相对于基础客户机有变化，则必须创建新的基础客户机。 我们不

建议在 OS 客户机计算机上进行更改。 
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2.6 创建工厂层级 

简介 

在 SIMATIC Manager 组件视图中添加了工作站并定义了物理工厂的组态。 工厂视图用于

在软件结构中分配工厂拓扑。 

项目中的首要和最重要的任务之一是定义工厂层级 (PH, Plant Hierarchy)。 PH 是 OS 运
行系统外观的基础，也是 SIMATIC BATCH 集成的基础。 

创建 PH 

在我们的实例中，AS 项目 PH 的结构如下所示： 
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在两个自动化系统的“01_Plant_A”和“02_Plant_B”项目中创建 PH。 可以逐个创建各个层

级文件夹，也可以使用导入/导出助手 (IEA, Import/Export Assistant) 中的脚本文件自动创

建。 

请注意以下规则： 

● 工厂标识 (HID) 由块名称、CFC 图表名称和层级文件夹名称（有时）组成。 建议您

始终使用尽可能短的 HID。 建议使用的 CFC 图表名称（过程标签名称）必须在整个

项目中是唯一的。 这样可以避免必须要将层级文件夹名称集成到 HID 中（请参见下

文说明中如何进行 PH 设置的屏幕截图）。 

如果要使工厂命名约定基于一些附加的功能因素，仍可将层级文件夹名称集成到 HID 
中。 应限制 HID 的长度，以确保在所有 OS 编辑窗口中能够完整显示。 层级文件夹

名称中的字符数不可超过此限制。 字符数超过此限制的名称不能完整显示在 HID 
中。 

● 层级文件夹名称中不能使用以下特殊字符：[ . ] [ % ] [ / ] [ \ ] [ " ]。 
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进行 PH 设置 

右键单击多项目，然后选择“工厂层级 > 设置”(Plant Hierarchy > Settings)，使用 PH 的对

象属性调整 HID。 

选择一个子项目用作模板。 整个多项目的 PH 设置必须在 PCS 7 中保持一致。 

 

● 层级数应保持设置为 8 个，例如，可选的“从工厂层级获得诊断画面”(Derive 
diagnostic screens from the plant hierarchy) 资产管理功能可以自动创建最多 8 个层

级。 

● 使用“OS 区域”(OS area) 选项，可以决定应将哪个层级看作 OS 区域。 在没有专用的

组织层级时使用第一个层级，如本例所示。 



 创建和管理 PCS 7 项目 
 2.6 创建工厂层级 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 69 

● 默认情况下，在 PCS 7 中会激活“从工厂层级获得画面层级”(Derive picture hierarchy 
from the plant hierarchy)。 

因而会完全通过组态的 PH 数据获得 OS 画面层级。 用于 AS-OS Engineering 的“自
动运行功能”仍然受到支持（请参见 AS-OS Engineering 帮助中“用于 AS-OS 
Engineering 的自动运行功能”部分）。 

进行 AS 分配 

层级文件夹的对象属性在这方面起了重要作用。 以“reactorA”文件夹为例： 在“AS-OS 分
配”(AS-OS Assignment) 选项卡上，为“reactorA”文件夹分配一个自动化系统作为组件视

图中的工艺工厂；在本例中为 AS1_H 的图表。 

 

随后，每个层级文件夹均有一个被分配为工艺工厂、单元或功能的 AS，下载后的图表也

是在其中进行处理。 

现在，添加到层级文件夹的所有元素均将分配到此 AS。 如果将所选的分配传送到下级对

象，则从属层级文件夹会采用相同的 AS 分配。 可以通过注释“所有下层对象都有已选择

的配置”(All lower-level objects have the selected assignment) 进行识别。 
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同步 PH 

通过同步自动化系统的两个项目的 PH 生成包含两个 OS 服务器站的“20_OS”项目的 
PH。 
为此，使用命令“工厂层级 > 更新多项目”(Plant Hierarchy > Update in Multiproject)。 

 

 说明 
更多相关信息，请参考手册《过程控制系统 PCS 7；工程系统》(Process Control 
System PCS 7 Engineering System) 中的“创建工厂层级 (PH)”部分。 

 

 
 

 说明 
以下规则适用于 PCS 7 V7.0：例如，如果在“02_Plant_B”项目中更改“reactorB”层级文件

夹的名称，则在“02_Plant_A”项目中会自动反映该名称更改。 
如果使用 PCS 7 V6.1，则必须在每个项目中手动进行此更改。 
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进行 OS 分配 

必须先进行层级文件夹的 OS 分配，然后才能添加过程画面。 

添加到层级文件夹的所有元素均将分配到此 OS。 如果将所选的分配传送到下级对象，则

从属层级文件夹会采用相同的 OS 分配。 
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检查 PH 的一致性 

我们建议每次编辑工厂层级时均检查其一致性。 右键单击多项目。 选择“工厂层级 > 检查

一致性”(Plant Hierarchy > Check Consistency) 菜单命令。 

下面的屏幕截图显示了与 CFC 图表相关的命名冲突，这些图表属于不同的 AS 程序但属

于同一个多项目。 

 

在检查日志中，所有对象都将与它们的符号、项目名称以及工厂视图和组件视图的路径

（如果存在）一起显示。 
 

 说明 
我们建议务必要对整个多项目执行一致性检查，这将需要执行附加检查。 
要从总体上了解所有相关检查，请参考手册《过程控制系统 PCS 7；工程系统》(Process 
Control System PCS 7 Engineering System) 中的“如何检查 PH 的一致性”部分，也可以

只通过单击日志中的“帮助”(Help) 按钮获得相关信息。 
通过菜单命令“选项 > 工厂层级 > 打开检查日志”(Options > Plant Hierarchy > Open 
Check Log)，无需再次运行检查就可以显示日志。 
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2.7 分摊组态工作 

概述 

如今的标准做法是不分摊多项目中的工程管理工作。 

但是，如果您的目标是希望通过一起工作来缩短组态时间，则从 PCS 7 版本 7.0 SP1 开
始，就是哪种方法最适合的问题，因为现在已引入了多用户工程以及多项目工程功能。 

多项目工程 

将其中的各个项目分配到多个分布式工程师站进行编辑。 PCS 7 提供了相应的系统功能

来管理、分布和合并这些项目。 在此方案中，这些项目仍然可以保留在多项目网络中，

也可以在编辑期间检出。 
 

 说明 
有关详细信息，请参考手册《过程控制系统 PCS 7；工程系统》 
(Process Control System PCS 7 Engineering System) 和下列链接的补充读物，快速入门

指南《多项目工程》(Multiproject Engineering)： 
(http://support.automation.siemens.com/WW/view/en/22258951) 

 

使用 SIMATIC BATCH 的多项目工程 
 

 说明 
有关详细信息，请参考下列链接的“使用 SIMATIC BATCH 的多项目工程” 
(Multiproject Engineering with SIMATIC BATCH) 组态说明： 
(http://support.automation.siemens.com/WW/view/en/23785345) 

 

它基于“多项目工程”组态说明 (ID: 22258951)，介绍了处理包含批生产功能的项目时必须

考虑的特殊因素。 
 

 说明 
从 PCS 7 V7.0 开始，在 SIMATIC BATCH 手册的“分布式多项目工程”部分介绍了用户要

遵循的操作步骤。 使用此操作步骤也可以测试分布式多项目中的批生产。 
 

http://support.automation.siemens.com/WW/view/en/22258951
http://support.automation.siemens.com/WW/view/en/23785345
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多用户工程 
 

 说明 
如果您使用 PCS 7 V6.1 SPx，则本部分与您无关，因为该版本没有提供多用户工程功

能。 
 

除多项目工程外，从 PCS 7 版本 7.0 SP1 开始，还提供了同时处理同一个用户程序（AS 
项目的 CFC/SFC）的可能性。 在这种情况下，特定项目可保持在其存储位置。 多项目

存储在中央工程师站上，该工作站必须安装有 Windows Server 2003 操作系统。 可以通

过网络从多个工程师站打开和编辑单个项目。 

通过组合式网络同时处理一个项目仅对 CFC 和 SFC 有效。 在 CFC/SFC 中已经改进了

一些特定的功能，其中包括故障安全功能，多个用户同时访问相同数据时通过该功能可保

证系统完整性和数据一致性。 
 

 说明 
更多相关信息，请参考手册《过程控制系统 PCS 7；多项目/多用户工程》 
(Process Control System PCS 7 Multiproject/Multiuser Engineering) 和 PCS 7 DVD 上的

“PCS 7 V70 in-practice Multiuser.pdf” 文档。 
 

选择适当的操作步骤 
 

 说明 
如果您使用 PCS 7 V6.1 SPx，则本部分与您无关，因为该版本没有提供多用户工程功

能。 
 

哪个操作步骤更好？ 

● 对于通过网络在中央 ES 上组态所有项目 

● 对于将项目分散到分布式 ES，并因此通过网络组态多项目 

由于要通过网络访问，所以远程组态速度比本地组态速度慢。 不管是从 ES 服务器读取

数据还是将数据写入，总是需要使用网络。 

进行少量更改时，比起必须要检出和再检入项目，这种减速还不是太明显。 

如果是进行大量更改，则更适合在本地进行工作，因为检出和检入所需的时间会相对更少

些。 

是通过多用户工程集中保存项目并执行远程访问还是使用分布式多项目工程的功能更节省

时间，将由组态涉及的工作量决定。 请参见下图的直观表示。 
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Qualitative comparison of engineering costs with/without extraction
Required time

Complexity and scope of engineering work

Basic effort for
check-in/check-out.

Local configuration: project data are transferred to 
another ES for editing.
(check-in/check-out)

Remote configuration: project data remain on 
central ES and are edited via the network.

(no check-in/check-out)
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组态硬件（AS 和 I/O） 3
 

简介 

本部分介绍实例项目 ("Comp_MP") 在硬件配置 (HW Config) 中的设置。 

屏幕截图概要描述了具有 CPU 417-4H 和 CP 443-1/CP 443-5 Ext 的 H 系统的属性以及

具有 CPU 417-4 和  
CP 443-1/CP 443-5 Ext 的标准 AS 的属性。 其它 CPU 或 CP 的属性对话框可能稍有不

同。 

在项目中使用 SIMATIC PDM 时请注意以下说明： 

S7-400 CPU 从固件版本 5.1 开始支持数据记录路由。 CPU 为此也必须组态为使用此固

件版本。 对于所有其它 CPU，所需路由功能必须使用 CP 443-5 Ext 来实现。 

3.1 常规 CPU 设置（H 系统和标准 AS） 
PCS 7 具有 CPU 的最佳默认设置，因此对于指定项目，只需设置少数几个参数。 

在 HW Config 在线帮助中详细介绍了所有的参数。 在以下几个小节中介绍 PCS 7 的一些

特殊特征。 这些小节中还包含相关建议、要保留默认设置的参数以及需要调整以适合特

定项目的参数。 

以蓝色书写的 CPU 参数与 H 系统有关。 运行期间，可以在 H 系统中更改这些参数，也

可以将它们载入 H 系统。 有关 H 系统中的 CPU 设置的所有特殊信息请参见“H 系统的特

殊设置”部分。 

在 HW Config 中，在 CPU 的对象属性中进行以下设置。 
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3.1.1 启动 

可以在“启动”(Startup) 选项卡上勾选与 CPU 启动特性相关的参数。 我们建议您保留默认

设置。 

 

尤其是启用了“暖启动”(Warm restart) 设置时更是如此。 在这种情况下，当前过程参数不

会重置为其初始值。 

另外，PCS 7 AS 总是配有备用电池和 RAM 存储卡这一事实也是影响其启动特性的一个

重要因素。 
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3.1.2 周期/时钟存储器 

“周期/时钟存储器”(Cycle/Clock Memory) 选项卡的设置： 

 

扫描周期监视时间 

请不要更改 PCS 7 项目的默认扫描周期监视时间值“6000 ms”，以确保 CPU 性能监视和

紧急停止（防止关闭）的有效性。 

输入/输出过程映像大小 

输入/输出过程映像大小取决于所有 DP 从站的 I/O 地址。 
在 HW Config 菜单命令“视图 > 地址总览...”(View > Address Overview...) 中，您可以看

到当前正在使用的 I/O 地址空间的总览。 此处列出的输入或输出的最高地址（无诊断地

址）必须在组态的过程映像范围内。 
在 PCS 7 中，所有通道驱动程序块（如 CH_DI）均组态为过程映像中的符号地址，不直

接访问 I/O。 
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3.1.3 过程映像分区 (PIP, Process Image Partition) 

简介 
 

 说明 
故障安全应用不需要以下设置，因为这些应用不使用过程映像分区（请参见《提纲 - B 部
分 - 过程安全》）。 

 

使用过程映像分区 

可以在 OB 1（默认）中针对过程映像存储器执行过程映像更新，也可以为每个循环中断 
OB 更新过程映像分区。 

通常，我们建议对 PCS 7 使用过程映像分区。否则，会因为 OB 1 的无固定周期循环导

致出现所谓的“非等距动态响应”，尤其对于闭环控制更是如此。下图旨在说明此情况： 

 

 

① 如果没有为 OB 35 组态过程映像分区（过程映像仅在 OB 1 中更新），OB 35 将
被执行三次，并且，既不受过程影响，也不会影响过程。 

分两个步骤执行组态 

1. CPU 属性： 
将最多 15 个空闲过程映像分区中的一个分配给循环中断 OB 
（例如 OB 35 – 100 ms） 
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2. 模块属性： 
将模块地址分配给过程映像分区，从而分配给所需的循环中断 OB 

 

由分配到过程映像分区的循环中断 OB 自动更新相关的过程映像分区。 在极个别情况

下，也可以通过用户组态的系统调用触发过程映像分区的自动更新。 

这可确保真正在启动循环中断 OB 时读取输入（例如，处理控制器），而且会根据循环

（输入 – 处理 – 输出：IPO）写入输出。 

 

① = 过程映像分区 PIPx 
 

 说明 
有关过程映像与过程映像分区之间关系的背景信息，请参考手册《过程控制系统 PCS 
7；工程系统》(Process Control System PCS 7 Engineering System) 中“设置过程映像”
部分。 
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3.1.4 组态过程映像分区 

在“循环中断”(Cyclic Interrupts) 选项卡上进行以下设置。 

 

“执行”列 

在“执行”(Execution) 列中，设置所需用户程序的循环时间。 

在单个循环中（500 ms 或 1,000 ms），除了有主过程外，通常还有慢过程和几个快过

程。 
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“优先级”列和“相位偏移”列 

对于标准应用，请不要更改“优先级”(Priority) 列。 

若是存在几个要同时调用的循环中断 OB 时，我们建议为优先级较低的 OB 设置相位偏

移。 例如，在 1,000 ms 时依次调用 OB 38 到 OB 32。除了循环时间还可以使用相位偏

移分散循环中断的执行时间。 下表给出了本实例的参数分配： 

 

循环中断 OB 执行（处理部分） 相位偏移 

OB 32 1,000 ms (150 ms) 100 ms (>70+20) 

OB 33 500 ms (70 ms) 30 ms (>20) 

OB 34 200ms (20ms) 0 

“过程映像分区”列 

为包含用户程序的每个循环中断 OB（OB 30 到 OB 38）分配一个过程映像分区。 
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3.1.5 本地数据要求 

本地数据从逻辑块的声明部分获得，集中存储在本地数据存储区。 这意味着，每次向图

表添加 FB 或 FC 的实例，本地数据要求都会提高。 

在“存储器”(Memory) 选项卡上，可以定义各个独立 OB 在工作存储器中的本地数据大

小。此值必须要超过特定本地数据要求。 

通常会按优先级为每个循环中断 OB 分配本地数据大小。 例如，OB 30 具有优先级 7，
OB 38 具有优先级 15。 
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组态本地数据要求 

建议将项目中使用的循环中断 OB 的本地数据大小设置为 1,024。 还要注意将优先级 24 
到 28 设置为值 1,024。因为其中包含 OB 100 和异步错误 OB。 

例如，如果未在 OB 37 和 OB 38 中集成任何块，则可将本地数据要求减少到 256，而释

放的内存可用于其它优先级。 

检查本地数据要求 

如果本地数据要求超过组态的大小，则下次编译图表时会显示警告，提示您增加本地数据

存储空间。 

使用 CFC 编辑器比较本地数据要求和 CPU 中的空间大小。 使用菜单命令“选项 > 图表 > 
参考数据”(Options > Chart > Reference Data) 打开该编辑器，可在其中查看“本地数

据”(Local Data)。 其中组态过低的 OB 将显示为红色。 

 

最大本地数据量取决于 CPU；例如，CPU 417 的最大本地数据量是 65,536。 
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组态通信资源 

最大通信作业数也取决于 CPU，大致相当于 AS 的最大过程对象 (PO) 数。  

例如，CPU 417 最多可处理 10,000 个通信作业。 例如，BSEND、BRCV、ALARM、

ALARM_8、ALARM_8P、NOTIFY 和 AR_SEND 的块实例始终需要一个通信作业。 

检查通信资源 

使用 CFC 编辑器查看 CPU 中的通信资源数。 使用菜单命令“选项 > 图表 > 参考数

据”(Options > Chart > Reference Data) 打开该编辑器，可在其中查看“统计数

字”(Statistics)。 

 

3.1.6 诊断/时钟 

时间同步 

为了便于评估过程数据，过程控制系统的所有组件必须使用相同的日时钟，以便可以按时

间顺序正确地分配消息，而不受生成这些消息的时区影响。 这通常需要使用一个 OS 服
务器或外部日时钟主站 (SICLOCK) 作为日时钟主站。 这样，工厂总线上的其它所有操作

员站和自动化系统都可以从此时间主站获得时间，因此它们的时间都是相同的。 
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正是因为这个原因，对于同步的 PCS 7 工厂中的每个 AS，总是将同步设置为“作为从

站”(As slave) 同步类型。 

从“诊断/时钟”(Diagnostics/Clock) 选项卡激活 CPU 中的时间同步。 

 

设置自动化系统的 CPU 作为时间从站。 这些 CPU 从工厂总线上的激活时间主站接收时

间。 
 

 说明 
对于配有集成以太网接口的 S7-400 CPU PN I/O，《PCS 7 时间同步》(PCS 7 Time 
Synchronization) 手册中包含的组态信息适用： 
(http://support.automation.siemens.com/WW/view/en/28518882) 
部分： 

• “组态 SICLOCK TM” 

• “如何在 AS 上设置 NTP 模式的时间同步” 
 

http://support.automation.siemens.com/WW/view/en/28518882
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确认触发报告 (ATR) 

使用“确认触发报告 SFB 33-35”(Acknowledgment-triggered reporting of SFB 33-35) 选
项，能够抑制重复报告“波动”信号，直到发出确认为止。 这有助于使消息列表更加清晰，

以及缓解通信系统的压力。 

然而，建议您不要激活 ATR，原因如下： 

● 可能会导致工厂操作员停止确认消息，甚至是“波动消息”之外的消息。 在这种情况

下，操作员不会意识到引发消息的事件已再次发生。 

● ATR 属性是 CPU 的一个属性，必须为每个 CPU 明确设置该属性。 如果没有为所有 
CPU 的该属性设置相同值，则可能导致操作员采取不同的消息响应行为。 

● 此时，仅当已确认了上一个信号变化（上一个进入消息）时，ALARM (SFB 33)、
ALARM_8 (SFB 34) 和 ALARM_8P (SFB 35) 块才会报告信号变化。 无论 PCS 7 中
的“需要确认”属性如何设置，该属性均适用于这些块上的所有信号。 

● 随后只有通过执行完全 CPU 下载才能更改此设置。 

● 还可以使用“确认错误”OS 功能阻止在调试期间或过程标签出错时出现“波动消息”。 
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3.2 H 系统的特殊设置 
“H 参数”(H Parameters) 选项卡中的设置： 

 

高级 CPU 测试的参数 

“对 RAM/PAA 比较错误的响应”(Reaction to RAM/PAA comparison error) 应继续设置为

“TROUBLESHOOTING”工作模式。 H CPU 提供一种功能，可以检测存储器错误、修复

简单存储器错误以及自动返回“RUN 冗余”系统模式。 
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备用 CPU 的更新 

每当 H 系统从“RUN 单机模式”转到“RUN 冗余”系统模式时，都会更新备用 CPU。 此过

程通常被称为“连接和更新”。 

在连接阶段，处于 RUN 模式的 CPU 会将所有块复制到停止的 CPU 中。 在更新阶段，

复制后发生更改的数据块值将更新。 
 

 说明 
有关“连接和更新”主题的详细说明，请参见手册《STEP 7 - 容错系统》(STEP 7 - Fault-
tolerant Systems)。 
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计算用于更新备用 CPU 的监视时间 

为避免在更新的关键阶段影响正在进行的过程，系统提供四个监视时间，当超出监视时间

时即可取消更新。 

为此，请单击“计算”(Calculate)。 在打开的对话框中会显示用于更新备用 CPU 的监视时

间。 

 

所谓的 H 参数取决于 DP/PA 从站的最大数量、PROFIBUS 传输速度以及 S7 程序中的 
DB 大小。 在线帮助中介绍了要输入到这三个输入域中的用户程序数据。 
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冗余 I/O 

如果组态了冗余 I/O 模块，请确保此处设置的 DB 编号与用户 DB 的编号不会发生冲突。 

为冗余 I/O 设置钝化响应时，应注意只有某些特定的模块才支持通道选择性。 
 

 说明 
除非 H 系统的整个冗余 I/O 具有“按通道”属性，否则必须为钝化方案设置“按模块”（请参

见手册《过程控制系统 PCS 7 V7.0 发布的 PCS 7 模块》(Process Control System PCS 
7 V7.0 Released PCS 7 Modules)）。 
PCS 7 V6.1 不支持“按通道”钝化方案。此时，只能选择“按模块”钝化方案。 

 

3.3 组态工业以太网 CP 443-1 

3.3.1 为使用 H 系统的工厂 A 组态 CP 443-1 

必须组态两个机架上的 CP 443-1，以实现 
CPU（此处为 Plant_A）与工厂总线间的冗余连接。 

连接工厂总线 

输入正确的 MAC 地址，建立与工厂总线的连接。 
 

 说明 
H 系统中的两个 CP443-1 单元必须始终以不同的 MAC 地址进行组态。 
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网络设置 

1. 在“传输媒介/双工”(Transmission medium/duplex) 域中指定“自动设置”(Automatic 
setting)。 
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2. 请确保已选中“激活连接的快速切换”(Activate fast switchover of connection) 选项。 
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时间同步 

激活 SIMATIC 模式下的时间同步。 
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3.3.2 为使用标准 AS 的工厂 B 组态 CP 443-1 

连接工厂总线 

输入正确的 MAC 地址，建立与工厂总线的连接。 
 

 说明 
在采用 ISO 协议的工厂总线中，每个 MAC 地址只能使用一次。 
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网络设置 

在“传输媒介/双工”(Transmission medium/duplex) 域中指定“自动设置”(Automatic 
setting)。 
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时间同步 

激活 SIMATIC 模式下的时间同步。 
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NTP 模式 

配有集成以太网接口的 S7-400 CPU V5.x PN I/O 只能通过 NTP 进行同步。 

目前并非所有 PCS 7 组件均支持 NTP 模式。 因此，为了实现 IE 包的时间同步，必须同

时使用这两种模式。 如果两个时间服务器都运行在同一 PC 上，则较差的优先级设置可

能导致时间偏移。 在这种情况下，使用支持这两种模式的 SICLOCK 是一种有效的解决

办法。 

需要一台 NTP 服务器（例如 SICLOCK 或 PC）以同步 S7-400IE 的时间。 它只向连接

的 NTP 客户机发送纯粹的 GMT 时间，不含时区信息。 
 

 说明 
有关组态的更多信息，请参见手册《PCS 7 时间同步》(PCS 7 Time Synchronization)： 
(http://support.automation.siemens.com/WW/view/en/28518882) 
“组态 SICLOCK TM”和“如何在 AS 上设置 NTP 模式的时间同步”部分。 

 

3.4 CP 443-5 Ext 的 PROFIBUS 设置 

简介 

在 PCS 7 中，每个作为 PROFIBUS 主站的 CP 443-5 Ext 都分配有自己的 PROFIBUS 
网络和自己的 DP 主站系统（单主站系统）。 

因此，每个 H 系统均连接到两个 PROFIBUS 网络，二者互为冗余 DP 主站系统。 

下述设置对 H 系统和标准系统均适用。 

http://support.automation.siemens.com/WW/view/en/28518882
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“常规”选项卡中的设置 

1. 在 HW Config 中，打开 CP 443-5 Ext 的属性对话框。 

 

  说明 
始终将地址 2 分配给作为 PROFIBUS 主站的 CP 443-5 Ext。 应保留地址 1，用于将

编程设备连接到 PROFIBUS 以进行维护。 保留地址 0，用于将 ES 连接到 
PROFIBUS。 



 组态硬件（AS 和 I/O） 
 3.4 CP 443-5 Ext 的 PROFIBUS 设置 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 101 

2. 建立到 PROFIBUS 网络的连接。 按“新建”(New) 分别为每个 CP 443-5 Ext 创建新的 
PROFIBUS 网络。 

 



组态硬件（AS 和 I/O）  
3.4 CP 443-5 Ext 的 PROFIBUS 设置 

 SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
102 操作手册, 09/2009, A5E02122388-01 

3. 可以为每个 PROFIBUS 网络进行网络设置。 

 

应在 PCS 7 中保留默认的“DP”配置文件。 

根据连接的 DP 从站和 PROFIBUS 段的长度设置传输率。 在某些情况下，可将 DP 
主站系统的传输速度从默认的 1.5 Mbps 增加到 12 Mbps，以实现更快的信号时间。 
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4. 使用“选项”(Options) 按钮将总线结构添加到组态中，并因此优化过程的 DP 总线参

数。 

 

  说明 
有关“规划 PROFIBUS 硬件”主题的详细说明，请参见手册《SIMATIC NET 
PROFIBUS 网络》(SIMATIC NET PROFIBUS Networks)。 
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“工作模式”选项卡中的设置 

在 CP443-5 属性对话框的“工作模式”(Operating Mode) 选项卡中，将 DP 模式设置为

“DPV1”。 

 

DPV1 工作模式包括过程自动化的扩展，它不仅包含周期性数据传输，还包含就参数分

配、操作、可视化和智能可编程控制器的中断控制而言的非周期性数据交换。  

此外，DPV1 有三种其它的中断类型： 

● 状态中断 

● 更新中断 

● 制造商特定的中断 

  说明 
DPV1 设置让您能够连接和操作不支持 DPV1 的 DP 从站。 
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“选项”选项卡中的设置 

同时也在“选项”(Options) 选项卡上进行以下设置： 

 
 

 说明 
必须激活数据记录网关，才能使用 PDM 的数据路由功能。 
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NetPro 视图 

最终在 NetPro 中显示 H 系统和标准 AS 的以下网络结构： 
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3.5 I/O 设备的组态 
请参考关于 I/O 组态的“已发布 PCS7 模块”列表。此列表中的组件和模块均已通过 PCS 7 
测试，并且得到 PCS 7“生成模块驱动程序”功能的支持；因此，也可以使用。 

3.5.1 ET 200M（H 系统和标准 AS）的组态 

简介 

下面将介绍将 ET 200M 组态为典型 DP 从站。 DP 从站的名称应基于工厂或工厂网络的

命名约定，以便在维护时能够迅速地找到故障。 
 

 说明 
有关组态 ET 200M 的详细分步说明，请参见手册《过程控制系统 PCS 7 工程系统》

(Process Control System PCS 7 Engineering System) 中的“组态分布式 I/O（标准）”部
分。 

 

实例： 2550C01CA04 

 

25: 生产设备的简称 

50: 控制室的名称 

C01C： 机架的名称和位置 

A04： 模块插槽 

如果 DP 子网中出现错误，则会在 OS 上生成一条消息，消息内容包括有关故障从站位置

的信息。 
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 说明 
以下命名约定适用于 HW Config 中的所有组件： 
名称不应超过 14 个字符。 生成模块驱动程序（CFC 编译）时，CFC 块实例使用来自 
HW Config 的名称。 CFC 块名称最多可包含 16 个字符。 模块驱动程序向导将来自 HW 
Config 的名称缩短到 14 个字符，并且始终添加“_1”。 
请确保所分配的名称唯一。 仅仅更改名称的字母大小写不会使名称唯一，因为 OS 编译

过程并不考虑大小写。 
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步骤 

1. 在 HW Config 目录（PCS 7 配置文件）中，从 PROFIBUS DP/ET 200M 文件夹选择

适当的 IM 153-2HF。 

选择与所用的背板总线（无源或有源）以及实际要使用的 IM 153 HF 模块上标明的产

品版本相匹配的 IM 153 HF。  
通常在 PCS 7 中使用有源背板总线。 

2. 在该 DP 从站属性中，输入 PROFIBUS DP 从站的 DP 地址。 还可以为该 DP 从站选

择子网（此处为 PROFIBUS (0)）。 使用 H 系统时，系统会自动建立与冗余子网 
PROFIBUS (1) 的连接。 
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3. 每次添加不同的 DP 从站时都会更新 PROFIBUS 网络的总线参数。 必须选中选项“激
活总线参数的周期性分配”(Activate cyclic distribution of the bus parameters)。 

 

4. 计算 H 系统监视时间时包含“Ttr”（Target Rotation Time，目标轮转时间）值。 
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5. 只有使用冗余系统时，“H 参数”(H Parameters) 选项卡才可用： 

 

  说明 
计算更新监视时间时包含用于 PROFIBUS 的这些 H 参数。 总线上已组态的 DP 从站

越多，CPU 参数中的这两个 H 参数的值就越高，而更新的监视时间就越长。 
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6. 10.0 s 用作时间同步的同步间隔。 
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7. 最后，激活“工作参数”(Operating Parameters) 选项卡上的“运行期间更换模

块”(Replace modules during operation) 选项。 
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3.5.2 输入和输出的符号名称 

可以在 HW Config 中直接输入符号。 例如，以下屏幕截图显示了适用于化工厂的典型信

号列表。 

 

这些符号会自动添加到符号表，随后可在 CFC 中使用。 
 

 说明 
还可从 Excel 文件中导入硬件信号的列表。 只能直接在符号表中进行此操作。 

 

3.5.3 组态 I/O 模块的一般规则 

简介 

通常，模块的通道只有在连接相应的执行器、传感器或等效电阻之后才会激活。 此方法

能避免运行期间 PCS 7 OS 中出现不必要的诊断消息。 

使用某些模块时，通道被组合成通道组（例如，包含 8 个通道的 AI8x12Bit 模块可以由 4 
个通道组组成，每组 2 个通道）。 在此情况下，只要将两个通道之一连接到信号，就会

激活该组。 此情况下还必须至少连接一个等效电阻。 
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模拟量输入 (6ES7331-7KF02-0AB0) 

测量类型取决于由模块供电的传感器（2 线传感器）是否在 AI 模块上运行，或者该传感

器是否从外部电源获得电源（4 线传感器）。 

将根据组态显示模块测量范围的设置。 该设置必须适合所连接的传感器，而且为避免损

坏模块，必须在初次施加电压之前完成该设置。 

 

当 PCS 7 MOD_D1 驱动程序块为编译 OS 启动诊断中断后，将自动为具有诊断功能的模

块生成消息。 
 

 说明 
有关“MOD_D1”驱动程序块（包括可用消息）的说明，请参见手册《过程控制系统 PCS 7 
库》(Process Control System PCS 7 Library)。 
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应禁用“超出限制时硬件中断”(Hardware interrupt at limit violation) 选项。 可在 PCS 7 中
使用图表中的通道驱动程序块功能实现这一点。 

 

 说明 
有关 ET 200M 模块模拟工程的信息（包括对各种手册的参考），请参见以下 FAQ： 
(http://support.automation.siemens.com/DE/view/en/20780602) 

 

模拟量输出 (6ES7332-5HD01-0AB0) 

需要组态输出对 CPU STOP 的响应方式。 在本例中，输出没有电流或电压（OCV 设
置）。 

 
 

 说明 
对于 ET 200M 分布式 I/O 中的模块（例如具有四个通道的模拟量输出模块），所有通道

的通道特定的设置“对 CPU STOP 的响应”(Reaction to CPU STOP)（OCV、KLV、
USV）必须完全相同。 

 

http://support.automation.siemens.com/DE/view/en/20780602


 组态硬件（AS 和 I/O） 
 3.5 I/O 设备的组态 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 117 

过程映像分区 (PIP, Process Image Partition) 

将之前在 CPU 属性中为循环断 OB 定义的过程映像分区分配给 I/O 模块（请参见“为过程

映像分区分配参数”部分）。 该步骤会在循环中断 OB 执行之前和之后将这些 I/O 信号的

值与 CPU 中的过程映像值同步。 

要执行此操作，打开模块属性和“地址”(Addresses) 选项卡，并设置所需过程映像分区

（本例中为 TPA1）。 过程映像分区的分配随后应用于整个模块和所有 I/O 信号。 

 
 

 说明 
通常的做法是，最初给所有模块分配一个中等的程序周期（例如 500 ms 或 1000 ms），

该周期的整个过程由几个快过程和慢过程组成。 
然后，只须将给定循环中断的相应过程映像分区，分配给含有快速控制或互锁信号（例如

50 ms 或 100 ms）的模块即可。 
此步骤可节省组态时间。 
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冗余 I/O 模块 

在 PCS 7 中，使用 ET 200M 模块通过冗余分布式 I/O 在现场级实现容错。 
 

 说明 
“冗余 I/O 模块的组态”文档介绍了相关结构、接线以及要使用的组态。 可以从西门子工业

自动化与驱动技术服务与支持获得此文档，网址为： 
(http://support.automation.siemens.com/WW/view/en/28430682) 

 

http://support.automation.siemens.com/WW/view/en/28430682
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3.6 运行中组态 (CiR) 

3.6.1 标准 AS 中的 CiR 

简介 

有一些过程单元不能在操作期间关闭。 这可能是由于自动化过程的复杂性或重新启动的

高昂代价所致。 尽管如此，可能还是会需要扩展或修改工厂。 

使用 CiR（Configuration in RUN，运行中组态），可在 RUN 模式下，在 HW Config 中
进行某些组态更改。 

只有当已在 HW Config 中激活该功能，并且已在 STOP 模式下装载过 AS 时，才能使用 
CiR。 

 

 说明 
有关 CiR（包括运行期间可执行的更改）的详细说明，请参见手册《过程控制系统 PCS 7 
工程系统》(Process Control System PCS 7 Engineering System) 中的“针对运行中组态

更改 (CiR) 组态分布式 I/O”部分。针对 RUN 模式下的组态更改 (CiR) 组态分布式 I/O 
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步骤 

1. 要在 HW Config 中激活 CiR，请右键单击子网（DP 主站系统）并在快捷菜单中选择

“激活 CiR 功能”(Activate CiR capability)。 
这会将 CiR 对象连接到相应的主站系统。 这样，可在将来组态和装载多个 DP 从站

（数量可调整）。 

 

2. 根据计划调整 CiR 对象的属性。 组态的数量用完后，可使用预定的 AS STOP 阶段再

次刷新设置。 

3. 激活 CiR 后，ET 200M 和 ET 200isp 内的第一个空插槽中即为 CiR 模块。 这样，可

在将来组态和装载多个模块（数量可调整）。 
根据计划调整 CiR 模块的属性。 

4. 激活 CiR 并检查 CiR 对象和 CiR 模块中的 CiR 设置后，“保存并编译”硬件配置，然后

将其下载到处于 STOP 工作模式的自动化系统中。 

然后可以使用 HW Config 的“下载”(Download) 对话框中的“RUN 模式下下载”功能。 
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3.6.2 H 系统的 CiR (H-CiR) 

在 H 系统中无需任何特殊设置即可获得上述 CiR 功能。 H 系统中没有 CiR 对象或 CiR 
模块，并且不需要显式激活此功能。 

用户可以立即使用“RUN 模式下下载”功能。 这将打开新的对话框，可在其中启动更改组

态所需的任务。 

 

此外，CPU 属性对话框中标记为蓝色的所有参数均可在 RUN 模式下修改。 
 

 说明 
有关 H 系统的 CiR 以及可进行的更改的详细说明，请参见手册《容错系统 S7-400H》

(Fault-tolerant Systems S7-400H) 中的“运行中的系统修改”部分。 
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3.7 集成现场设备 

3.7.1 有关设备集成的基本信息 

集成现场设备 

现场设备的项目工程分为两步： 组态和参数分配。 

下图概括了在 PCS 7 中集成设备的方法。原则上，在 PCS 7（从 PCS 7 V7.0 开始）中

可集成所有 PROFIBUS DP、PROFIBUS PA、HART 和基金会现场总线 (FF, 
Foundation Fieldbus) 设备。 

 



 组态硬件（AS 和 I/O） 
 3.7 集成现场设备 

SIMATIC 过程控制系统 PCS 7 提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 123 

通过对象管理器集成 

许多西门子设备均可使用对象管理器，例如 ET 200M。 在这种情况下，正确的术语为

“S7 从站”。 通过专用的 STEP 7 对象管理器执行 S7 从站的项目工程组态。 在 HW 
Config 中执行组态和参数分配。 

通过通用站描述 (GSD) 文件 80 集成为标准从站 

任何制造商的现场设备均可通过标准 GSD 文件集成（作为标准从站）。 此类集成用于 
PROFIBUS DP、PROFIBUS PA 以及 HART 设备。 通过 HW Config 设置组态。 设备的

默认参数分配也通过 GSD 文件进行定义。 然后必须使用专有工具进行参数调整；或者，

对于通过 EDD（Electronic Device Description，电子设备描述）文件集成的设备，可以

使用 SIMATIC PDM 进行调整。 

只有当主站知道设备特定的参数和数据格式时，才能在主站和现场设备之间进行数据交

换。 现场设备制造商以 GSD 文件的形式提供此“信息”。 

GSD 文件包含以下信息： 

● 设备制造商和标识号 

● 传输率和总线参数 

● 周期性通信的数据量和数据格式 

在 HW Config 中，成功将设备放置在 PROFIBUS 上后，即可右键单击设备以打开其对象

属性，定义所安装 GSD 文件的修订版本。 
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对于通过对象管理器集成的 S7 从站，则没有在此处指定 GSD 文件。 

现场设备制造商有时会发布新版本的 GSD 文件。 使用 SIMATIC Manager 可以方便地安

装 GSD 文件。 

要执行此操作，HW Config 必须为“空”，即必须关闭所有打开的项目。 

 

可通过“选项”(Options) 菜单中的“安装 GSD 文件...”(Install GSD File...) 选择并安装设备描

述。 
 

 说明 
如果集成了新设备，要使用 SIMATIC PDM 为其分配参数，则必须使用“管理设备目

录...”(Manage Device Catalog...) PDM 应用程序导入设备的 GSD 和 EDD 文件。 
 

使用 SIMATIC 过程设备管理器和 EDD 文件分配参数 

SIMATIC PDM 可为任何制造商生产的现场设备分配参数。 EDD（Electronic Device 
Description，电子设备描述）文件构成设备规范和非周期性通信的基础。 

EDDL（Electronic Device Description Language，电子设备描述语言）是一种由 
PROFIBUS 基金会规定的脚本语言，是唯一由 IEC (IEC 61804) 标准化的设备描述。 

该语言普遍适用，并便于为现场设备（传感器和执行器）创建跨供应商的设备描述。 

设备制造商以电子格式为各个设备提供相关描述。 EDD 文件描述设备的变量和功能，并

且还包含用于运行和可视化的元件。 
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打开 SIMATIC PDM 后，在“文件 > 对象属性”(File > Object Properties) 的“设备”(Device) 
选项卡上，可以定义与设备对应的 EDD 文件的存储位置和修订版本。 

 

现场设备制造商有时会发布新版本的 EDD 文件。 

只能使用“SIMATIC PDM/管理设备目录...”(SIMATIC PDM/Manage Device Catalog...) 导
入这些文件。 

设备制造商在 EDD 包中提供以下内容： 

● 设备描述（EDD 文件） 

● 词典/用户语言 

● 帮助文件（与功能和操作相关） 

● 手册（技术文档） 

● 通信描述（GSD 文件） 

● 画面 
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现场设备的诊断支持 

如上一页中的图片所示，在模块向导的帮助下，PCS 7 能够自动为 HART 设备、PA 设备

（配置文件 3.0 以上版本）、PROFIBUS DP 标准从站以及已发布模块创建诊断驱动程

序。 

还支持各种附件，例如 SIMOCODE PRO 和 DRIVE ES。 安装后，这些附件提供自动创

建诊断驱动程序所需的操作列表。 

也可以手动组态诊断驱动程序，但它们必须与系统图表分开创建。 

3.7.2 为现场设备组态和分配参数 

组态现场设备 

在《PCS 7 组态手册工程系统》(PCS 7 Configuration Manual Engineering System) 中，

从“组态分布式 I/O”部分开始，描述了现场设备的组态。  

“如何使用 SIMATIC PDM 组态智能现场设备”部分中描述了参数分配。 
 

 说明 
有关 PDM 可用功能（例如 Multiview（层级网络结构的视图）和 LifeList（设备和所连组

件的视图）等重要的 PCS 7 功能）的更多信息及其使用说明，请参见手册《SIMATIC 
PDM》。 

 

PROFIBUS DP 设备 

本文档中的“I/O 设备的组态 (页 107)”部分介绍了相关组态。 
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PROFIBUS PA 设备 

手册《PCS 7 组态手册工程系统》(PCS 7 Configuration Manual Engineering System) 中
的“如何组态 PA 设备”部分介绍了相关组态。 

必须在 DP/PA 连接器的对象属性中选中 PDM 复选框，才能将 Multiview 和 LifeList 功能

用于 PA 总线上的设备： 

 

对于 PA 现场设备，该选项默认选中。 

FF 设备 

有关组态和参数分配的信息，请参见以下文档： 

● 手册《DP/FF 连接器》(DP/FF Link)，所在位置： 
(http://support.automation.siemens.com/WW/view/en/24239833) 

● 文档“PCS 7 V70 in-practice DP7FF-Link.pdf”，位于 PCS 7 DVD 上的 Manuals 下 

http://support.automation.siemens.com/WW/view/en/24239833
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3.7.3 在 H 系统中组态现场设备的相关信息 

冗余接口 

简而言之，能够访问冗余接口的 DP 设备始终以冗余方式进行组态和连接（例

如 ET 200M、ET 200iSP）。 

无法访问冗余接口的 DP 设备连接在 Y 连接器的下游。 可在 Y 连接器下游组态的现场设

备的数量，受 244 个字节 I/O 范围的限制，这适用于各种情况。 

PA 设备始终以冗余方式连接在 DP/PA 连接器的下游。 

采用冗余和非冗余连接时，每个 DP/PA 连接器所允许的设备数受以下变量的限制： 

● DP/PA 耦合器的馈电电流（EX 时 110 mA，非 EX 时 1,000 mA） 

● 现场设备的电流消耗（通常为 12 mA） 

● 现场设备的地址范围（最大 244 字节的 I/O 数据，每个模拟值 5 个字节） 

● PROFIBUS PA 上的循环时间（如果需要满足特定用户要求） 

手册《过程控制系统 PCS 7 工程系统》(Process Control System PCS 7 Engineering 
System) 中的“如何组态 Y 连接器和 Y 耦合器”部分介绍了 Y 连接器和 DP/PA 连接器的组

态。 
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3.7.4 与在现场总线上集成现场设备相关的主题 

现场总线连接 

除了过程控制系统中现场设备的组态之外，还必须考虑现场总线的布局。 下列文档提供

了有关数量结构、物理总线特性、总线结构等内容的详细信息。 

 

主题 文档 

PROFIBUS DP (RS 485) SIMATIC NET 手册《PROFIBUS 网络》 
(PROFIBUS Networks) 

PROFIBUS DP 本质安全 (RS 485 iS) SIMATIC 手册《ET 200iSP 分布式 I/O》 
(ET 200iSP Distributed I/O) 

PROFIBUS PA SIMATIC 手册《DP/PA 耦合器、DP/PA 连接器和 Y 连接器总线

耦合器》 
(DP/PA Coupler, DP/PA Link and Y Link Bus Couplers) 

基金会现场总线 手册： 《DP/FF 连接器》 
(DP/FF Link) 

可以在工业自动化服务与支持门户或 PCS 7 手册集中找到上述文档。 
 

 说明 
PNO（PROFIBUS 用户组织）的“安装指南”包含在其它文档中，可以在下载区找到这些

文档，网址为： 
(http://profibus.com/) 

 

http://profibus.com/
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组态网络连接 4
 

简介 

安排并组态了工作站后，需要组态 ES/OS 服务器与自动化系统之间的连接以及自动化系

统相互之间的连接，然后将其下载到各个工作站。 

必须将相关工作站的 CP 连接到工厂总线，以便装载这些连接。 ISO 协议用于过程通

信。 

OS 客户机和 OS 服务器一样，也连接在终端总线 (TCP/IP)。 不在 PCS 7 中组态终端总

线上的 CP 和连接。 

实例 

对于本实例，网络组态如下： 

● 2 个 AS 

● 1 个 ES 

● 1 个冗余 OS 服务器对 

● 4 个 OS 客户机 

 

对于基于站的组态（如本实例中那样），必须先合并各个子项目的网络（子网）。 
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4.1 合并多项目中的网络 

步骤 

1. 在 SIMATIC Manager 中，右键单击该多项目，然后选择“多项目 > 更新项

目”(Multiproject > Update Projects)。 

2. 选择“以太网”(Ethernet)，然后单击“执行”(Execute)，以打开“合并/分离工业以太

网”(Merge/Separate Industrial Ethernet) 对话框。 可在此选择各个子网。 
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S7 子网 ID 显示在属性中（所有工厂总线组件都是这样）。 
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随后，可在 NETPRO 中访问交互项目网络视图。 

 

3. 在此视图中单击工业以太网工厂总线，以获取多项目中 PC 站及自动化系统的 MAC 地
址的总览。 
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4.2 组态连接 

4.2.1 AS/OS 连接 

步骤 

1. 在 OS 子项目中打开 NETPRO 视图。 

2. 要添加 S7 连接，请右键单击 OS 的 WinCC 应用程序，然后选择选项“插入新连

接”(Insert New Connection)。 

3. 选择 SIMATIC H 站 AS1 的 CPU。 

4. 为 H 系统选择“容错 S7 连接”(Fault-tolerant S7 connection)，然后单击“确定”(OK)。 
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5. 为 AS 命名该连接。 
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6. 以相同的方式连接 AS2（AS2 的 S7 连接不是容错的）。 
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SERVER1B 连接的建立方式与 AS1 和 AS2 的相同。 

 
 

 说明 
从两个 OS 服务器（ES 亦然）到同一自动化系统的连接必须使用相同名称（在本例中为

“AS1”）。 
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4.2.2 ES/AS 连接 

简介 

必须组态 ES-AS 连接，以便使用“OS 仿真”ES 功能。 使用“OS 仿真”，可以在将 OS 服
务器项目（例如图片、脚本等）装载到 OS 服务器之前，先在 ES 上对项目功能进行测

试。 为使用此仿真功能，ES-AS 连接与 OS-AS 连接的名称必须相同。 

步骤 

1. 在 ES 子项目中打开 NETPRO 视图。 

2. 要添加 S7 连接，请右键单击 ES 的 WinCC 应用程序，然后选择选项“插入新连

接”(Insert New Connection)。 

3. 选择 SIMATIC H 站 AS1 的 CPU。 为 H 系统选择“容错 S7 连接”(Fault-tolerant S7 
connection)，然后单击“确定”(OK)。 

4. 以相同的方式连接 AS2（AS2 的 S7 连接不是容错的）。 
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4.2.3 AS/AS 连接 

与标准系统通信 
 

 说明 
在 PCS 7 中，容错系统与标准系统之间通常不能进行容错通信。 
而您可以创建两个标准 S7 连接，然后以应用特定块解决方案的方式实现容错。 
更多相关信息，请参见手册《容错系统 S7-400H》(Fault-tolerant Systems S7-400H) 中
的“通信”部分。 

CPU PLANT_A 

1. 要添加 S7 连接，需要首先右键单击 SIMATIC H 站左侧的 CPU 417-4，然后选择选项

“插入新连接”(Insert New Connection)。 

2. 选择 SIMATIC 站 AS2 的 CPU 作为该连接的目标。 选择“S7 连接”(S7 connection) 作
为连接类型，然后单击“确定”(OK)。 

 

3. 对 SIMATIC H 站的伙伴 CPU 重复这两个步骤。 
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CPU PLANT_B 

工厂 B 中 SIMATIC 站 AS2 连接的总览： 
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容错通信（2 路或 4 路） 

容错系统之间的通信始终使用“容错 S7 连接”。 可用的连接伙伴如下： 

● 对于简单工厂总线 

– 配有 CPU 41xH 和 2x CP 443-1 的 AS 

– 配有 2x CP 443-1 的 H 系统 

– 配有 CP 1613 的 PC 站 

● 对于冗余工厂总线 

– 配有 CPU 41xH 和 2x CP 443-1 的 AS 

– 配有 2x 或 4x CP 443-1 的 H 系统 

– 配有 2x CP 1613 的 PC 站 
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4.3 下载连接 

简介 

组态了工作站并创建了网络连接后，必须将组态数据下载至站点（AS/PC 站）。 

 

此时的先决条件为，必须利用“组态目标系统”功能 (创建和管理 PCS 7 项目 (页 25)) 使 
OS 服务器的站组态编辑器可用。 

为此，在 NetPro 中编译并保存组态。 如果组态未出错，则所有站的状态颜色均为“白
色”。 

对于初次组态，请为所有自动化和 PC 站执行“PLC > 下载到当前项目 > 所选站”(PLC > 
Download to Current Project > Selected Stations) 功能（仅在 AS 处于 STOP 模式时可

行）。 
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对于新建的或经过修改的 S7 连接，选择相应的连接并使用“PLC > 下载到当前项目 > 所
选连接”(PLC > Download to Current Project > Selected Connections) 功能（当 AS 处于 
RUN 模式时可行）。 

 

 说明 
对 AS 使用“PLC > 下载到当前项目 > 连接和网关”(PLC > Download to Current Project > 
Connections and Gateways) 功能时，当前 AS-AS 连接会短暂地中断。 该中断不会影响 
CFC 库标准块（REC_R、REC_BO）的输出参数。 
对于 PC 站，仅“PLC > 下载到当前项目 > 所选站”(PLC > Download to Current Project > 
Selected Stations) 功能可用。 

 

如果 AS-OS 连接发生变化，则需要编译并下载 OS。 
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下载到 ES 

下载工作站时，始终从“工程师站”开始。 

1. 选择 ES，然后 

2. 选择菜单命令“PLC > 下载到当前项目 > 所选站”(PLC > Download to Current Project > 
Selected Stations)。 

下载到 OS 服务器 

也将组态下载到 SERVER1A 和 SERVER1B。 

下载到 AS 站 

“PLC > 下载到当前项目 > 所选站”(PLC > Download to Current Project > Selected 
Stations) 功能会将完整的组态（包括 HW Config）装载到 AS。 只有在 STOP 工作状态

下才能执行该功能。 
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组态 AS 功能 5
5.1 基础知识 

5.1.1 将块复制到主数据库 

步骤 

从所有用于组态的库（例如 PCS 7 Library 7.0）中，将全部需要的块复制到主数据库

（本例中为“Comp_LIB”）。 

请确保同时复制那些被其它块调用作多重背景块的块。 

 
 

 说明 
只有主数据库中的块才必须用于组态。 这能保证所有 S7 程序都将使用相同的块类型。 
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5.1.2 创建用户定义的工艺块 

块库 

在 PCS 7 中，可以很容易地创建用户特定块，也就是说可以用灵活的方式满足客户的特

殊要求。 用户定义的块始终包含用于 AS 的功能块、块图标以及用于 OS 的面板。 

请注意，务必考虑创建、维护和维修用户定义块所需的专业知识和所花的时间及费用。 
建议使用现有的 PCS 7 块库。 此方法的主要优点为，此类库中所包含块的维修和维护工

作均由相关部门负责，范围涵盖各个 PCS 7 版本。 这意味着可以减少项目团队的一份后

顾之忧，尤其在将来“旧”项目团队离开后要进行升级时。 

开始创建用户定义块之前，必须讨论以下问题。 

决定创建用户定义块时应考虑的标准 

● 检查现有 PCS 7 块库（例如 PCS 7 附件目录），以查看其功能能否满足客户要求。 

● 是否已存在能够满足客户要求的部门特定库？ 

● 能否修改现有 PCS 7 块库以满足客户要求（例如，只进行显示）？ 

● 要创建一个块还是多个块？ 

● 是否有待创建块所需功能的描述或规范？ 

● 将来能否执行用户定义块所需的维护和维修；是否需要一定的专业知识和时间？ 
 

 说明 
要创建此类块，请参考手册《PCS 7 块编程指令》(PCS 7 Programming Instructions for 
Blocks)，其中介绍了创建“与 PCS 7 兼容”的块所涉及的各个方面。 
请注意，用于 AS 块的 FB 编号范围已分配如下： 

• FB 1000 之前，为现有 PCS 7 块库预留 

• FB 1800 到 1999，为 PCS 7 系统预留 

• FB 1025 及以上编号，为 SFC 类型预留 

• FB 2000 到 2014，为 SIMOCODE Pro 库预留 
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5.1.3 创建用户定义的驱动程序块 

使用驱动程序块 

可以使用 PCS 7 创建驱动程序块，其创建方式与工艺块相同。 “驱动程序块”是为用户特

定的模块/设备处理信号和诊断信息的块。 

创建此类块的主要目的是实现向 PCS 7 层级驱动程序概念和 PCS 7 资产管理的集成。 
 

 说明 
要创建此类块，请参考相关版本 PCS 7 的手册《PCS 7 块编程指令》(PCS 7 
Programming Instructions for Blocks)。该手册介绍了创建“与 PCS 7 兼容”的驱动程序块

所涉及的各个方面。 
如有必要，创建驱动程序块时还应咨询西门子相关技术部门。 
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5.1.4 更改消息类、优先级和消息文本 

简介 

可以更改所有功能块的消息类、优先级和消息文本。 

步骤 

要执行此操作，请单击主数据库中的 FB，然后选择“特殊对象属性 > 消息”(Special Object 
Properties > Message)。 

 
 

 说明 
首先在主数据库中进行更改，然后更新 AS 子项目 S7 程序中的 FB（请参见“更新 S7 程
序中的块 (页 152)”部分）。 
进行这些更改后，仍可对自动化系统进行增量下载。 如果在 PCS 7 消息组态中进行了更

改，则需要编译并下载 OS 服务器。 
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5.1.5 更改属性 

简介 

可以更改每个功能块的属性，例如，“S7_m_c = true”表示 OS 中需要块/块 I/O。 

步骤 

例如，在块 I/O 属性对话框中的相应选项卡上设置属性。 

 
 

 说明 
首先在主数据库中进行更改，然后更新 AS 子项目 S7 程序中的 FB（请参见“更新 S7 程
序中的块 (页 152)”部分）。 
进行这些更改后，仍可对自动化系统进行增量下载。  
如果对块属性进行更改，可能需要编译并下载 OS 服务器。 有关有此要求的 S7 属性，请

参见手册《PCS 7 块编程指令》(PCS 7 Programming Instructions for Blocks) 中的“参数

的系统属性”表。 
 



组态 AS 功能  
5.1 基础知识 

 提纲 A 部分 - 组态准则 
152 操作手册, 09/2009, A5E02122388-01 

5.1.6 更新 S7 程序中的块 

简介 

可以将更改从主数据库传送至各个 S7 程序。 

步骤 
要执行此操作，请选择主数据库中的块文件夹，然后选择“选项 > 图表 > 更新块类

型...”(Options > Charts > Update Block Types…)。 

 
 

 说明 
如果在块文件夹中选择一个或多个块，则只会更新这些块。 其优点是能加快更新过程。 
有关此过程的更多信息，请参见手册《过程控制系统 PCS 7 工程系统》(Process Control 
System PCS 7 Engineering System) 中的“如何更新块类型”(PCS 7 V6.1) 或“如何更新块

类型和 SFC 类型”(PCS 7 V7.0) 部分。 
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以下规则适用于 PCS 7 V7.0： 

使用该系统功能，除 AS 子项目中的 S7 程序外，主数据库（来自过程标签类型/模型的

块）的 S7 程序也会自动更新。  

S7 程序中来自主数据库的 SFC 类型也可以集中更新。 
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5.1.7 在 CFC 中组态的要求 

步骤 

1. 在 CFC 编辑器中使用“选项 > 设置 > 编译并下载”(Options > Settings > Compile and 
Download) 打开相应对话框，并指定编译图表时应跳过的 DB 和 FC 编号范围。 

对于多项目中的所有 S7 程序，编号范围的设置应相同。 

实例： 

– DB： 1 到 60 

– FC：60 到 700 
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2. 插入太多的块会引起 SCL 编译器中止编译过程。 50 个块的限值足以满足典型组态情

况的需要。 

因此，对于选项“每个运行组或 OB 中安装的块数：”(Installed blocks per runtime 
group or OB:)，应保留其默认值“50”不变。 相关的警告应保持激活状态。 

3. 从 PCS 7 V7.0 开始，提供“下载程序后为其生成映象文件以便下次比较”(Generate 
image of downloaded program for comparison) 选项。 这能验证某组态阶段（调试、

生产等）之后的阶段是否有用或必要。 

如果激活该选项，随后即可查看要下载更改的详细信息；可使用“下载”(Download) 对
话框中的“显示更改”(Show Changes) 按钮实现此目的。 必须提供 VXM 工具

（Version Cross Manager，包括授权）。 
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5.1.8 驱动程序概念 

PCS 7 V6.1 和 PCS 7 V7.0 的一般原理 

驱动程序块充当 I/O 模块、PI 设备和 S7 程序间的接口。 随后可在 CFC 编辑器中使用的

输入/输出信号及状态信息（例如，断线）通过驱动程序块提供。 通道驱动程序提供“信号

值无效”(QBAD) 和“信号值状态”(Quality) 输出。 

 

PCS 7 具有通道驱动程序（用于信号本身）和模块驱动程序（用于诊断子网、机架和模

块）。 通道驱动程序必须在 CFC 中组态。 

在硬件配置中定义每个通道的符号名（例如，H4711 GO+）。 将驱动程序块链接到此符

号名会将此 I/O 信号分配给该信号驱动程序。 

系统在编译 CFC 图表时会自动生成模块驱动程序。 

根据模式和诊断，模块驱动程序包含在硬件配置中进行的所有设置。 

例如，如果整个 ET 200M 出现故障，则只有一条指向该故障 ET 200M 的过程控制消

息。 模块及其通道的各条过程控制消息会自动被抑制。 这样可防止出现过程控制消息爆

发，从而使故障排除更易于进行。 会继续评估受影响的过程消息。 
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PCS 7 V7.0 的驱动程序块“CPU_RT” 

从 PCS 7 V7.0 开始，始终通过“生成模块驱动程序”插入驱动程序块“CPU_RT”。 要求使

用来自 PCS 7 Library V7.0 的驱动程序块。 

在过载时可使用“CPU_RT”采取新的控制器和周期行为。 所有自动化系统在过载时都采取

新的行为。 

也可执行 AS 负载的性能分析。 性能分析取决于 CPU 固件 (CPU FW)。 如果 CPU FW 
支持 SFC 78，则可通过“CPU_RT”读取性能数据。 性能数据显示在 PCS 7 资产管理的诊

断区域（请参见“集成资产管理”部分）。 
 

 说明 
可以在文档“PCS 7 V70 in-practice CPU-RT.pdf”中找到有关“CPU_RT”的所有必要信息。 
此文档位于 PCS 7 V7.0 DVD 上的 \_Manuals\ 文件夹中。 
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5.1.9 AS 的周期负载和存储器利用率 

周期负载 

建议在工程的开始阶段确定 AS 的周期负载。 

可使用以下方法： 

● 对于 PCS 7 V7.0 及相应 AS，使用“CPU_RT”块（SFC 78，请参见前一部分） 

● 对于 PCS 7 V6.1 和 V7.0，可以用组态的方式确定周期负载，并且随时都可以使用 
CFC 块将其下载到 RUN 模式下的 AS 中。 

  说明 
FAQ： 如何在线 (http://support.automation.siemens.com/WW/view/en/22000962)计
算自动化系统 (AS, Automation System) 的周期负载？  

调试 AS 后周期负载的典型限制： 

● 对于标准 AS，限制为 70% 周期负载，以便系统能够将时间片用于其它操作（例如，

用于通信作业）。 

● 对于 H 系统，此限制应为 60% 周期负载，因为冗余需要更多的时间片。 

存储器负载 

可以在 AS 的在线属性中确定存储器利用率（工作存储器）。 默认情况下，用于存储来

自 CFC 的更改的装载存储器的警告限制设为 90%。 此值可在 CFC 中进行更改。 

http://support.automation.siemens.com/WW/view/en/22000962
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5.2 创建 CFC 图表 

5.2.1 过程标签类型（模板） 

过程标签类型（模板）是项目特定的块互连。 模板用作特定自动化功能的模型。 

实例 

下面显示了 PCS 7 库中的阀控制过程标签类型。 

这里，通过输入和输出的驱动程序块以及 INTERLOK 和 VALVE 标准块对阀进行控制。 
驱动程序块的 QBAD 输出与 VALVE 块的 CSF 错误输入互连。 

 

PCS 7 库中提供大量过程标签类型。 它们作为项目基础，可以/必须针对特定项目的自动

化功能进行调整。 

每个项目中还需要创建用户特定的过程标签类型。 应采用与 PCS 7 库中过程标签类型相

似的方式，创建用户特定的过程标签类型。 
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创建自定义过程标签类型的建议 

我们有如下建议： 

● 使用注释域（例如，用于描述逻辑）。 

● 始终使用通道驱动程序。 

● 始终将通道驱动程序的 QBAD 和 Quality 输出与工艺块互连。 

● 以简明易懂的方式在过程标签类型 CFC 表单上排列块： 例如，总是从左向右排列，

或上向下排列。 

● 创建过程标签类型的变体。 例如，如果某阀门需要两个互锁块，则可为其新建一种过

程标签类型。 

● 在项目中使用各个过程标签类型之前，应进行测试。 可在测试项目中进行测试。 
 

 说明 
有关创建 CFC 的信息，请参见手册《过程控制系统 PCS 7 工程系统》(Process Control 
System PCS 7 Engineering System) 中的“创建 CFC 图表（常规）”部分；有关创建过程

标签类型的信息，请参见“通过过程标签类型创建过程标签（多项目）”部分。 
 

全部过程标签类型随后保存在主数据库中，并可以根据需要在其中进行编辑和更改。 

稍后会在项目中通过过程标签类型生成过程标签（副本） 
（请参见“使用导入/导出助手进行批量工程组态 (页 165)”部分）。 
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5.2.2 运行顺序 

运行顺序的原理 

会为每个 CFC（过程标签）创建一个运行组。 运行组被分配给一个循环 OB。因此，

CFC（过程标签）的所有块都被分配给这个循环 OB。在 PCS 7 中这一点很重要，因为

它能确保通道驱动程序和工艺块会在运行顺序的同一周期中执行。 

 
 

 说明 
如果包括具有启动特征的块，则这些块也会集成在 OB 100 中。 
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运行组的执行时间 

可通过将相应运行组插入到下列循环中断 OB 之一，来设置运行组的执行时间。 

 

循环中断 OB 时间帧的默认值 优先级的默认值 

OB 30 5 s 7 

OB 31 2 s 8 

OB 32 1 s 9 

OB 33 500 ms 10 

OB 34 200 ms 11 

OB 35 100 ms 12 

OB 36 50 ms 13 

OB 37 20 ms 14 

OB 38 10 ms 15 
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优化运行顺序 

每个单独块的定时或者整个程序的定时均可使用“优化运行顺序”系统功能进行优化。 使用 
PCS 7 时，建议进行此优化。如果不想优化某些运行组（例如，带级联连接的 CFC），

则可将其排除在外。 

 

优化的好处在于，优化之后整个 S7 程序的全部过程标签会以相同的顺序执行。 
 

 说明 
如果运行组包含故障安全块，则不能激活该选项。 
有关运行顺序及其优化方式的更多详细信息，请参见手册《过程控制系统 PCS 7；工程

系统》(Process Control System PCS 7; Engineering System) 中的“如何优化运行顺序”部
分。 
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5.3 创建 SFC 图表 

有关 SFC 的常规信息 

顺序功能图 (SFC) 是一种分阶段执行的顺序控制系统，这些阶段会根据某些条件会从一

个状态前进至下一状态。 顺序控制系统通过模式和状态变化来控制诸如 CFC 图表之类的

功能，并且有选择性地处理这些功能。 

在 SFC 编辑器创建 SFC。 SFC 及 SFC 类型的块图标在 OS 编译期间自动生成。 
 

 说明 
更多相关信息，请参考手册《过程控制系统 PCS 7 工程系统》(Process Control System 
PCS 7 Engineering System) 中的“创建顺序控制系统 (SFC)”部分。 

 

SFC 类型 

在 SFC 中，有“SFC 图表”和“SFC 类型”对象类型。 

SFC 类型允许定义顺序控制和可扩展接口。 有关 SFC 类型/实例的优缺点，请参见上述

手册。 
 

 说明 
在“提纲 C 部分 - 使用 SFC 类型的设备阶段”(Compendium Part C - Equipment Phases 
with SFC Types) 中详细介绍了 SFC 类型的创建。 

 

如果在项目中多次使用步进顺控程序 (SFC)，通常优先选用 SFC 类型。 这些实例放置在 
CFC 图表中，与功能块类似。 SFC 类型存储在主数据库中。 

从 PCS 7 V7.0 开始，可以在主数据库中集中编辑 SFC 类型，并且会自动更新项目中的

所有实例。 此外，在 CFC 的图表引用数据中列有 SFC 实例的访问方法。 
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5.4 使用导入/导出助手进行批量工程组态 

简介 
下图显示一个实例，其中 CAD/CAE 系统用作数据的接口。 导入/导出助手 (IEA, 
Import/Export Assistant) 使用此数据自动生成过程变量。 

 

功能 

● 使用已测试的过程标签类型和模型标准化工厂库 

● 从更高级别的 CAD/CAE 环境导入工厂数据（例如，过程标签列表或 I/O 列表） 

● 根据导入的过程标签列表和过程标签类型自动生成 AS 组态 

– 创建工厂层级 

– 编辑存储的过程标签 

● 自动获得 OS 画面层级、自动连接块以及在画面中定位 

● 自动创建 OS 归档 

● 使用适当的图形工具（例如，CFC 和 SFC）包含各个过程对象 

● 将已优化的参数导回至 CAD/CAE 环境 



组态 AS 功能  
5.4 使用导入/导出助手进行批量工程组态 

 提纲 A 部分 - 组态准则 
166 操作手册, 09/2009, A5E02122388-01 

使用导入/导出助手 

通过“导入导出助手”可以方便地使用过程标签类型和模型创建功能图。 还可以导出在 
PCS 7 中创建的文件（例如，工厂文档），在 Excel 中进行编辑，然后将其导回  
PCS 7。 

创建过程标签类型和模型时，请按以下步骤操作： 

● 创建过程标签类型，并进行测试以确保其功能正常。 若稍后更改则会耗费时间。 

● 多项目中的所有工作人员都应使用相同的过程标签类型。 应为每个工作人员分配一个

名称范围，用于其所创建的 IEA 文件。  
这样就能轻松地将文件输入多项目中。 工作人员应有权导入过程标签类型，但不应允

许他们更改模板。 应始终集中进行更改，然后再将更改提供给工作人员。 

● 只应在组态阶段使用 IEA。 应在 FAT（Factory Acceptance Test，工厂验收测试）期

间或调试期间对图表中的参数和互连进行更改。  
由于用户在图表中进行更改，而未在 IEA 文件中进行更改，因此任何新的 IEA 导入操

作都可能覆盖所做更改。 

● 在 FAT 期间以及随后工厂处于过程模式时，利用过程对象视图可以表格形式对通过 
IEA 创建的图表进行编辑。 也可以在其中进行导出和导入（请参见“过程对象视图中的

批量工程 (页 167)”部分）。 
 

 说明 
手册《过程控制系统 PCS 7 工程系统》(Process Control System PCS 7 Engineering 
System) 中的“通过过程标签类型创建过程标签（多项目）”部分介绍了 IEA 的使用过程。

更多相关信息，请参见文档“PCS 7 - 使用入门第 1 部分和第 2 部分”。 
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5.5 过程对象视图中的批量工程 

简介 

在过程对象视图中，整个项目的所有基本控制数据均可显示在面向过程控制的视图中。 
这意味着多项目包含其中所有项目的数据。 

过程对象视图主要在 FAT 和调试期间使用。 这些任务涉及到集中高效处理大量数据。 过
程对象视图具有一个优点，即可以集中编辑对象的所有可更改标签/值（白色背景）。  

编辑过程标签和 CFC 时，可以一致地显示并记录所有方面（自动化、I/O 连接、消息、

操作和监视）。 通过跳转到 CFC、SFC、HW Config 以及 OS，您能够编辑在表格中无

法编辑的标签/值（例如，模型参数定义、画面内容等）。 
 

 说明 
有关过程对象视图的布局和使用说明，请参见手册《过程控制系统 PCS 7 工程系统》

(Process Control System PCS 7 Engineering System) 中的“在过程对象视图中编辑大量

数据”部分。 
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过程对象视图的过滤器功能 

过程对象视图中的过滤功能是一个综合工具。 作为实例，以下显示了一个具有多种标准

的过滤器： 

● 过程标签类型“FI”（流量测量） 

● “MEAS_MON”类型的块 

● “MO_PVHR”I/O（测量范围上限） 

 

使用各种过滤器功能“常规”、“块”及“I/O”可以轻松地对值进行选择、检查和修改。 

导出与导入输入/输出和消息 

通过导出和导入属性，可以对参数、信号和消息信息执行如下操作： 

● 将其导出到某个文件 

● 使用标准应用程序进行编辑 

● 将其重新导入。 
 

 说明 
在导入/导出期间将忽略过滤器。 始终会将（不使用过滤器时能显示在当前视图中的）所

有数据全部导出。 
 

如果要编辑大量的数据，这些功能将尤为有用。您不必使用 CFC 编辑器逐个打开图表来

编辑 I/O，因为层级文件夹中所有图表的 I/O 均被自动导入。 
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编辑位于所选层级文件夹及其所有下级层级文件夹中的图表（按照在过程对象视图中进行

的选择）。 
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过程对象视图中的其它重要功能 

● 查找/替换 

● 测试模式 

● 显示用于故障安全应用的数据 

● 将视图拆分为两个窗口（参见上图） 

● 提供包含通过 WinCC 变量记录以表格形式组态的归档变量的视图 

● 定义用户列 

● 撤销 

应尽可能使用过程对象视图。 与 CFC 相比，此视图具有较大优势。 过程对象视图还提

供工厂层级的所有选项。 

5.6 使用 Version Cross Manager (VXM) 
Version Cross Manager 能检测工程项目的不同修订版本之间的差异。 它可以比较整个项

目与其它项目（硬件配置、CFC/SFC 图表、块类型和实例、信号或运行顺序等），从而

检测出缺失、添加或发生变化的对象。 
 

 说明 
手册《过程控制系统 PCS 7 工程系统》(Process Control System PCS 7 Engineering 
System) 中的“使用 VXM 比较项目版本”部分介绍了可使用 Version Cross Manager 的各

种情况及使用方法。 
 

5.7 使用 Version Trail 进行归档/版本控制 
多项目应定期进行归档（包括所有项目和主数据库）。 如果在工程组态阶段的调试和 
FAT 期间进行许多更改，则应每天创建归档/备份。 

尽管数据归档后无法进行更改，但可以使用 Version Trail 选件包为归档生成版本并进行

管理。 这表示，可以使用 Version Cross Manager 在所定义的归档版本之间进行比较。 
 

 说明 
手册《过程控制系统 PCS 7 工程系统》(Process Control System PCS 7 Engineering 
System) 中的“归档/版本控制和文档编制”部分介绍了归档（包括使用 Version Trail 进行归

档）时的操作步骤。 
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编译和下载 6
6.1 使用 PCS 7 V6.1 编译用户程序 

程序下载到 CPU 前必须先进行编译。在编译过程中，还会检查程序错误和警告。 

可以编译整个程序或者仅编译更改的部分。 

 

建议对 PCS 7 始终选择以下选项： 

● 生成模块驱动程序 (Generate module drivers) 

● 更新采样时间 (Update sampling time) 

● 删除空运行组 (Delete empty runtime groups) 

● 进行文本互连 (Make textual interconnections) 
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6.2 使用 PCS 7 V6.1 下载用户程序 

步骤 

首先必须将硬件配置和网络组态下载至 CPU（如果尚未执行此操作）。 

然后从 CFC 或 SFC 下载 S7 程序，PCS 7 会确保按正确顺序执行该下载步骤。 
 

 说明 
不要直接从 SIMATIC Manager 下载块。 

 

如果修改了功能或功能块的接口，则需要编译整个程序并对该程序执行完全下载。 

在此情况下，CPU 会停止。 
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完全下载前回读 

例如，如果控制器的参数在 OS 上进行了更改，这些参数将直接写至 AS。 现在，如果从 
ES 执行完全下载，则在 OS 上更改的参数会被从 ES 下载的参数覆盖。 

必须在 CFC 图表中手动执行回读参数设置。 基本原则是只需回读由 OS（如果适用，或

者其它通信伙伴）更改的参数。 这通过激活“OCM”选项来确保。 如果激活“所有参数”(All 
parameters) 选项，则回读 AS 的全部当前程序状态，包括逻辑状态。 在后面的完全下载

期间，这可能会导致出现非期望的程序状态以及工厂状态。 
 

 说明 
有关回读参数设置涉及的其它步骤，请参考手册《过程控制系统 PCS 7 工程系统》

(Process Control System PCS 7 Engineering System) 中“如何下载到所有 CPU”部分。 
 

如果回读了参数，则随后会自动编译整个程序。 执行编译后，整个程序会下载到 AS。 
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6.3 使用 PCS 7 V7.0 编译用户程序 
程序下载到 CPU 前必须先进行编译。在编译过程中，还会检查程序错误和警告。 

可以编译整个程序或者仅编译更改的部分。 

 

建议对 PCS 7 始终选择“生成模块驱动程序”(Generate module drivers) 选项。 
 

 说明 
从 PCS 7 V7.0 开始，“进行文本互连”(Make textual interconnections) 和“删除空运行

组”(Delete Empty Runtime Groups) 这两个选项不再在编译对话框中；而是显示在 CFC 
编辑器中。 每次编译都更新采样时间。 
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6.4 使用 PCS 7 V7.0 下载用户程序 
首先必须将硬件配置和网络组态下载至 CPU（如果尚未执行此操作）。 

然后从 CFC 或 SFC 下载 S7 程序，PCS 7 会确保按正确顺序执行该下载步骤。 
 

 说明 
不要直接从 SIMATIC Manager 下载块。 

 

如果修改了功能或功能块的接口，则需要编译整个程序并对该程序执行完全下载。 

在此情况下，CPU 会停止。 
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完全下载前回读 

例如，如果控制器的参数在 OS 上进行了更改，这些参数将直接写至 AS。 现在，如果从 
ES 执行完全下载，则在 OS 上更改的参数会被从 ES 下载的参数覆盖。 完全下载前会出

现提示，询问是否要从 AS 到 ES 回读参数。 

基本原则是只需回读由 OS（如果适用，或者其它通信伙伴）更改的参数。 这通过激活

“OCM”选项来确保。 如果激活“所有参数”(All parameters) 选项，则回读 AS 的全部当前

程序状态，包括逻辑状态。 在后面的完全下载期间，这可能会导致出现非期望的程序状

态以及工厂状态。 

 

如果回读了参数，则随后会自动编译整个程序。 执行编译后，整个程序会下载到 AS。 
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6.5 使用 PCS 7 V6.1 的 OS 编译 

简介 

在编译 OS 时，所有相关的工程数据都会传送至 OS 项目（画面层级、SFC 可视化、块

图标、变量、消息、OS 归档数据等）。 同时还会生成或更新服务器数据。  
 

 说明 
建议使用“面向区域”(Area-oriented) 编译模式。 此为默认设置。 该设置必须用于 PCS 7 
Web 选件和 PCS 7 资产管理功能。 

 

步骤 

1. 在 SIMATIC Manager 中通过 OS 项目的快捷菜单启动 OS 编译。 
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2. 检查是否已组态网络连接（需要有已命名的 S7 连接）。 通过“连接”(Connection) 按钮

为每个自动化站选择连接路径。 

 

3. 选择“命名的连接”(Named Connection)。 
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4. 最后，指定要编译的数据及编译范围。 

 

5. 现在，单击“完成”(Finish) 以启动编译。 
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6.6 使用 PCS 7 V7.0 的 OS 编译 

简介 

在编译 OS 时，所有相关的工程数据都会传送至 OS 项目（画面层级、SFC 可视化、块

图标、变量、消息、OS 归档数据等）。 同时还会生成或更新服务器数据。 
 

 说明 
建议使用“面向区域”(Area-oriented) 编译模式。 此为默认设置。 该设置必须用于 PCS 7 
Web 选件和 PCS 7 资产管理功能。 

 

步骤 

1. 在 SIMATIC Manager 中通过 OS 项目的快捷菜单启动 OS 编译。 
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2. 检查是否已组态网络连接（需要有已命名的 S7 连接）。 通过“连接”(Connection) 按钮

为每个自动化站选择连接路径。 可以选择或取消选择一些区域以缩短编译时间。 

 

3. 选择“命名的连接”(Named Connection)。 
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4. 指定所需的编译数据以及编译范围，然后，单击“完成”(Finish) 以启动编译。 

 

5. 现在，单击“完成”(Finish) 以启动编译。 

创建/更新块图标 

从 PCS 7 V7.0 开始，“创建/更新块图标”(Create/update block icons) 功能不再作为 OS 
编译的选项列出。 如果在画面属性中设置了“从工厂层级获得块图标”(Derive block icons 
from the plant hierarchy) 复选框，则在编译 OS 时会自动调用该功能。 

插入了作为“编译 OS”(Compile OS) 或“创建/更新块图标”(Create/update block icons) 更
改功能的 PCS 7 面板。 

● CFC 图表中发生更改时会更新相关画面。 

● 单独插入一个新的块图标。 

● 对于所有其它更改，将更新画面的所有块图标。 

如果“@@PCS7Typicals.pdl”、“@PCS7Typicals.pdl”或“@PCS7TypicalsXYZ.pdl”模板画

面之一发生更改，则所有工厂画面会进行更新。 
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组态 OS 功能 7
7.1 项目设置 

7.1.1 定义服务器分配 

简介 

为了使客户机能够显示分布式系统中不同服务器的过程数据，客户机需要相关数据的信

息。 为此生成的服务器数据（包）将提供给客户机。 客户机需要所有服务器的服务器数

据，这些服务器的过程信息应对客户机可见。 

系统在 OS 编译和下载期间自动创建/更新服务器数据。 或者，可通过在 SIMATIC 
Manager 中使用“服务器数据”(Server data) 快捷菜单命令手动生成服务器数据。 
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步骤 

1. 为每个 OS 客户机项目分配所需的服务器数据（本例中为冗余 OS1 的数据包）。 为
此，使用快捷菜单命令“分配 OS 服务器…”(Assign OS Server…)。 
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2. 在打开的对话框中进行分配。 不同颜色的条目指示不同的状态。 详细信息请参见帮助

（“帮助”(Help) 按钮）。 

 

  说明 
OS 服务器数据只需分配给 OS 客户机项目一次。 对 OS 服务器下载（完全下载或仅

下载更改）时，会自动为客户机提供新的 OS 服务器数据。 OS 客户机启动过程模式

时也会执行更新。 
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成功执行分配后，还可在 WinCC 项目管理器中 OS 客户机项目的“服务器数据”(Server 
data) 下看到结果。 

 
 

 说明 
服务器数据包括 ES 的计算机名称（要从该 ES 中自动下载服务器数据）。 如果无法连接

到 ES，则运行系统重新启动时，OS 客户机会尝试从服务器直接下载服务器数据。 
如果项目移至另一路径或另一 ES（另一个计算机名称），则服务器数据必须重新生成

（手动或通过编译 OS）并重新分配至 OS 客户机项目。 
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7.1.2 选择首选服务器 

简介 
为了能够利用冗余服务器对并实现持久可操作性（即使在切换到冗余伙伴时也能如此），

您应该将 OS 客户机的一部分分配给主服务器，并将另一部分分配给备用服务器。 

“首选服务器”即为冗余服务器对中的 OS 服务器，如有可能，OS 客户机会与之互连；也

就是说，只要该 OS 服务器可用，OS 客户机就会从该处获取数据。 

这就要求这两个 OS 服务器上的连接组态保持一致且 PCS 7 端无错误（冗余）。 如果连

接组态不一致或冗余连接存在错误，则 OS 客户机会切换到激活/无错误连接的 OS 服务

器。 
 

 说明 
如果“组态服务器数据”(Configure the Server Data) 对话框中未输入首选服务器，则 OS 
客户机会与指定为主服务器的 OS 服务器互连。 
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“组态服务器数据”(Configure the Server Data) 对话框中包含的信息源自服务器数据，服

务器数据被分配给相应的 OS 客户机。 

 

实例 

CLIENT01、CLIENT02 > 分配给 SERVER1A 

CLIENT03、CLIENT04 > 分配给 SERVER1B 

以下规则适用于 PCS 7 V7.0： 

被参考 OS 客户机由已分配的基础 OS 客户机自动分配给相同首选服务器。 不允许进行

不同的分配。 
 

 说明 
有关此主题的更多信息，请参见手册《过程控制系统 PCS 7；容错过程控制系统》

(Process Control System PCS 7 Fault-tolerant Process Control Systems 
(http://support.automation.siemens.com/WW/view/en/15234019))。  

 

http://support.automation.siemens.com/WW/view/en/15234019
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7.1.3 选择和组态标准服务器 

简介 

 

对于分布式系统中的客户机，如未指定唯一的服务器前缀（例如，对于变量），则组态应

为其提供数据的标准服务器。 

如果没有标准服务器，则尝试访问客户机的本地数据仓库（例如，内部变量）。 如果该

客户机上没有本地数据仓库（如消息和归档），则访问尝试被拒绝并出错。 
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步骤 

在“标准服务器”(Standard Servers) 对话框中，为该对话框中单独列出的组件指定标准服

务器。 

 

仅为“报警”(Alarms) 组件和“SSM”（Split Screen Manager，分屏管理器）组件选择标准

服务器。 
 

 说明 

• 报警 

必须始终为报警组件指定标准服务器。 在客户机本身上不能组态任何报警记录。 成功

操作后在客户机上生成的操作员消息将保存于标准服务器上。 

• 变量 

不可以为变量组件指定标准服务器。 

• SSM（Split Screen Manager，分屏管理器） 

必须始终为 SSM 组件指定标准服务器。 如果客户机上组合了趋势组，则它们会保存

在标准服务器上并周期性地与冗余伙伴服务器同步。 
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7.1.4 使用 OS 项目编辑器 

简介 

在 OS 项目编辑器中，可对工厂操作员用来在过程模式下监控工厂的用户界面进行设置。 

OS 项目编辑器包括以下选项卡： 

 

选项卡 功能 

布局 (Layout) 设置目标计算机的屏幕分辨率，定义按钮用于工厂操作员在单个 
OS 区域与单个 OS 服务器间进行切换 

消息组态 
(Message 
Configuration) 

消息列表及区域分配的设置 

消息显示 
(Message 
Display) 

组态消息系统的运行行为，并显示消息页面或组显示中的消息 

区域 (Areas) 定义工厂操作员可在总览区中访问的区域 

运行窗口 
(Runtime 
Windows) 

定义调用面板和趋势时可打开的最多窗口数 

基本数据 (Basic 
Data) 

选择必须在更改后替换的对象。 可以选择以下对象： 

• 画面 

• 面板 

• 脚本 

常规 (General) • OS 项目编辑器使用的针对下载更改的设置 

• 对于“完全组态”(Entire configuration) 设置，必须执行完全下载。

• 运行项目编辑器时要替换的日志的设置 

在 ES 中创建 OS 项目时，OS 项目编辑器在后台打开并采用默认设置进行初始化。 

如果需要另外进行组态，从 WinCC 项目管理器启动 OS 项目编辑器并组态所需的项目设

置。 
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OS 客户机布局的实例 

 

必要时，也可在以后修改这些设置。 
 

 说明 
在“仅支持在线增量加载的组态”(Configurations that support online delta loading only) 模
式下，并非所有组态选项在 OS 项目编辑器中都可用。 在该模式下，只能更改那些不需

要完全下载 PCS 7 OS 的设置。 为了进行其它更改，需要在 OS 项目编辑器的“常
规”(General) 选项卡中切换至“全部组态（失去对在线增量加载的支持）”(Complete 
configuration (loss of support for online delta loading))。 
有关此主题的更多信息，请参见 WinCC 在线帮助。 

 



 组态 OS 功能 
 7.1 项目设置 

提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 193 

7.1.5 语言设置 

WinCC 中的语言设置 

WinCC 中有多个可用于设置语言的菜单。 以下解释了语言设置的重要性。 

WinCC 项目管理器中的菜单命令 

● “选项 > 语言”(Options > Languages) 菜单： 

可在此设置用户界面的语言。 

● “计算机 > 属性 > 参数”(Computer > Properties > Parameters) 菜单： 

可在此设置运行系统的语言。 也可以在此域中设置 WinCC 内项目文档打印输出的语

言。 

图形编辑器中的菜单命令 

● “视图 > 语言”(View > Language) 菜单： 

必须先选择运行系统中画面显示的语言，然后才能组态画面。 

报警记录中的菜单命令 

● “视图 > 语言”(View > Language) 菜单： 

– 以所选语言显示消息文本 

– 消息文本必须在文本库中编译 

运行系统的语言设置 

● 语言选项按钮： 

可在此设置运行系统的当前显示语言。 为此，需要将全部可切换的部分组态为相应的

语言。 
 

 说明 
WinCC 从 Simatic Manager 中打开时总是使用此处设置的语言。 仅当 WinCC 不从 
Simatic Manager 中打开时，才会使用最后一次退出程序前设置的相应语言。 
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7.1.6 服务器项目中的冗余设置 

步骤 
1. 在 OS 服务器项目中，打开“冗余”(Redundancy) 编辑器。 

2. 检查冗余伙伴设置是否正确，并激活所需的选项。 

 
 

 说明 
冗余伙伴可通过串行接口（零调制解调器电缆）连接，或从 PCS 7 V7.0 开始通过附加网

络 I/O 连接（在冗余伙伴间通过交叉网络电缆连接）。 
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在首次下载至目标计算机后，必须就有关冗余监视方面的问题，检查/调整一次目标计算

机上的冗余设置（通过 COM 端口或以太网接口进行连接的连接电缆），并单击“确
定”(OK) 进行确认。 

在 PCS 7 V6.1 中，可以使用 OS 服务器上的冗余对话框调整设置。 

从 PCS 7 V7.0 SP1 开始，则使用 Windows 资源浏览器中的 SIMATIC Shell 调整设置。 
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7.1.7 时间同步 

简介 

以下实例简要显示了对 OS 计算机激活时间同步。  

从 Windows 2000 Server 开始，所有的域控制器 (DC, Domain Controller) 均具有相同的

授权。 时间同步必须由担当“PDC 仿真器”运行主站的 DC 执行。  

时间信号来自连接有 DCF77 的 SICLOCK TM。 
 

 说明 
有关 PCS 7 可用的组态选项和相应的详细组态说明，请参见手册《PCS 7 时间同步》

(PCS 7 Time Synchronization)。 
(http://support.automation.siemens.com/WW/view/en/28518882) 

 

要求 

PDC 连接到外部 DCF77 时钟，该时钟提供精确的时间。 “DCF77 服务”软件用于执行 
PDC 同步。 

PDC 的“DCF77 服务”实例组态： 

 

http://support.automation.siemens.com/WW/view/en/28518882


 组态 OS 功能 
 7.1 项目设置 

提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 197 

所有 OS 计算机上的时间设置 

1. 必须在每台 OS PC 上检查/修改以下时间设置。 通过“开始 > 设置 > 控制面板 > 日期

和时间”(Start > Settings > Control Panel > Date and Time) 可以访问这些设置。 

2. 在所有计算机上的“时区”(Time Zone) 选项卡上，激活夏令时变化的自动调整设置，并

设置正确的时区（（GMT - 05:00）美国东部时间）。 
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3. 不得激活“Internet 时间”(Internet Time) 选项卡上的选项“自动与 Internet 时间服务器同

步”(Automatically synchronize with an Internet time server)。 
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4. 通过“开始 > 设置 > 控制面板 > 区域和语言选项”(Start > Settings > Control Panel > 
Regional and Language Options) 打开“区域和语言选项”(Regional and Language 
Options) 编辑器，并为所在位置组态正确的选项。 
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OS 服务器项目内“时间同步”(Time Synchronization) 编辑器中的设置 

工厂总线的时间同步借助 CP 1613 通过 OS 服务器和冗余 OS 伙伴服务器执行。 
 

 说明 
如果 ES 对 CP 1613 没有访问权限，则不能在此进行时间同步设置。 在此情况下，当下

载了 OS 项目后必须在两台服务器上均进行时间同步设置。 
首先启动的 OS 服务器的 CP 1613 用作主站。 如果该 CP 出现故障，则冗余伙伴承担主

站功能。 
 

在 OS 服务器项目中选择以下参数： 
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“显示访问点的符号名称”(Display symbolic name of the access point) 选项： 

从 ES 组态时间同步时，还可以显示由“<>”表示的访问点符号名称。 激活相应的复选框。 
当目标计算机在运行期间启动时，这些名称会分配给访问点。 

如果使用 CP 1613 的两个访问点，则以下模块通过 SIMATIC NET 分配给符号名称： 

 

符号名称 对话框域 
“组态 PG/PC 接口” 

对话框域 
“设置 PC 站” 

<CP 1613 (1)> CP 1613(ISO) CP 1613 

<CP 1613 (2)> CP 1613(ISO)<Board2 CP 1613(2) 

两个内部变量“@TimeSyncDevice1State”和“@TimeSynDevice2State”用于这两个访问

点。 这些变量用于在运行期间进行诊断，并显示访问点的状态。 设置为“从站”(Slave)、
“备用主站”(Standby master)、“激活主站”(Active master) 和“已取消激活”(Deactivated)。 

 

“过程控制消息”(Process controlling messages) 选项： 

发生同步问题的情况下会在运行期间显示过程控制消息。 对于过程控制消息 1012002-
1012005、1012018 和 1012021，可在“过程控制消息”(Process control messages) 域中

设置在运行期间过程控制消息显示的频率。 

激活“发送一次”(Send once) 复选框将使过程控制消息仅显示一次。 

如果要在运行期间多次发送过程控制消息，请取消激活“发送一次”(Send once) 复选框。 
在“每...分钟发送”(Send every ... minutes) 输入域中输入所需的值，或使用拨号控件。 
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OS 客户机项目中的计算机属性 

还必须在计算机的属性对话框中进行以下设置： 
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OS 服务器项目内“时间同步”(Time Synchronization) 编辑器中的设置 

OS 客户机从终端总线上的 OS 服务器接收时间。 

需要在客户机 OS 项目内的“时间同步”(Time Synchronization) 编辑器中进行以下设置： 
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OS 客户机项目中的计算机属性 

在此进行以下设置： 

 

参见 

http://support.automation.siemens.com/WW/view/en/27068495 
(http://support.automation.siemens.com/WW/view/en/27068495) 

http://support.automation.siemens.com/WW/view/en/27068495
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7.1.8 OS 客户机上的图形运行系统 

如以上屏幕截图所示，禁用 OS 客户机项目的计算机属性中的快捷键。 这可防止运行期

间访问操作系统。 
 

 说明 
但如果为了服务和诊断目的仍需访问操作系统， 则可根据事件在此启用或禁用组合键。 
此内容在常见问题解答“如何在运行期间通过事件触发 Windows 组合键的锁定/释放？”中
进行了介绍。 (http://support.automation.siemens.com/WW/view/en/27068495) 

 

要确保 Windows 任务栏在即便调用独立应用程序时（例如，“通过名称选择画面”、“通过

过程标签选择画面”、“用户权限”或“SFC 可视化”）也在过程模式中保持隐藏，必须在 
Windows 操作系统“任务栏和开始菜单属性”(Taskbar and Start Menu Properties) 下激活

“将任务栏保持在其它窗口的前端”(Keep the taskbar on top of other windows) 复选框。 

7.1.9 OS 服务器上的图形运行系统 

为减轻不同时用作操作员站的 OS 服务器的负载，建议采用其中一种措施： 

● 在 OS 项目编辑器的“布局”(Layout) 选项卡上选择“SIMATIC 服务器”(SIMATIC Server) 
服务器布局。 
通常可用于所有 OS 服务器，尤其对于那些拥有四个以上 OS 客户机的服务器。 
这样可分配用户管理器级权限并创建禁用快捷键的互锁。 

● 在“计算机属性”(Computer properties) 下的启动列表中取消激活图形运行系统及其关

联的应用程序，例如，CCTTRT 服务器（过程控制选项）或 SFCRT（SFC 块的可视

化）。 
由各 WinCC 编辑器向启动列表中添加的其它应用程序不可删除。 

  说明 
可用于高负载 OS 服务器和 CAS，以确保从此处访问 StoragePlus，该组件用于“连接”
或“断开”换出为备份的归档段（为达到此目的，在 GMP 环境中只需 Windows 
logon）。 
默认情况下对 CAS 取消激活图形运行系统。 

http://support.automation.siemens.com/WW/view/en/27068495
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7.2 可视化界面 

7.2.1 画面层级的结构 

可以为工厂创建多达 8 个级别的层级结构。 按钮用于在过程画面之间进行导航。 

 

导航的 AS 工程组态期间在 SIMATIC Manager 中分配过程画面。 也可在 SIMATIC 
Manager 中更改 OS 区域的显示名称。 但通常使用的名称与工厂视图中显示的名称相

同。 

 



 组态 OS 功能 
 7.2 可视化界面 

提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 207 

画面层级（画面树）在 OS 编译期间根据 SIMATIC Manager 中的工厂层级设置自动生

成。 
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7.2.2 过程画面的设计 

简介 

通常，根据一组与客户密切合作而制定的规范来创建过程画面。 必须考虑部门及公司特

定的标准和准则。 

在实例项目中，拟定了以下定义： 

功能设计 

此功能针对用户对象提供。 使用 OS 库中的面板。 

电缆设计 

 

颜色 黑色： 产品 

 黄色： 气体，N2 

 暗红色： 蒸汽，加热系统 

 绿色： 水 

 蓝色： 空气 

宽度 宽： 主产品电缆（线宽 4） 

 窄： 其它电缆（线宽 2） 

锅炉设计 

采用灰底黑线的图形方式表示锅炉。 锅炉的形状由 RI 流程图定义。 

使用静态文本指示锅炉容量。 填充量通过锅炉上的一个条显示。 
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画面导航 – 电缆的起始和终止 

中断的电缆由电缆末端的箭头标识。 

化学工厂过程画面的实例： 
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7.2.3 块图标/用户对象 

块图标是“用户对象”(UDO, User-Defined Object) 类型的图形对象，表示 OS 中的相应块

类型。 在 @@PCS7Typicals.pdl 典型画面中，可以找到 PCS 7 中使用的所有块类型/过
程标签类型的块图标模板。 

此典型画面中的图形对象在 OS 编译期间使用，并插入到过程画面中，而且还根据工厂层

级自动链接到相应的过程标签。 
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为一些 AS 块提供了多个块图标。 例如，阀的介质流向定义为垂直或水平方向时就属于

这种情况。 选择哪个块图标由相应块图标“类型”(type) 属性中的指示编号决定。 
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可在 CFC 中通过 AS 块的属性对话框进行选择和指定。 例如，以下屏幕截图显示了针对 
VALVE 块出现的选择框。 
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OS 库中提供了以下块图标： 

 

UDO 类型 关联的 AS 块 

控制器 CTRL_PID、CTRL_S、DOSE、FMCS_PID、FMT_PID 

模拟值组信号 ELAP_CNT、MEAS_MON、SWIT_CNT 

模拟值 RATIO_P、OP_A、OP_A_LIM、OP_A_RJC 

二进制值组信号 DIG_MON 

二进制值 OP_D、OP_D3、OP_TRIG 

电机 MOTOR、MOT_SPED、MOT_REV 

阀 VALVE、VAL_MOT 

其它 INTERLOK、SFC_PLAN、SFC_TYP 

7.2.4 自定义块图标/用户对象 

“创建/更新块图标”(Create/Update Block Icons) 功能使用以下模板画面： 

● 项目工程师创建的模板画面 

– 名称以“@PCS7Typicals”开始 

– 数量限制为 10 个 

● 画面“@@PCS7Typicals.pdl”的默认模板画面 

 

此功能会打开所有画面并根据名称的字母顺序确定画面的优先级。 

● 优先级 1： “@PCS7Typicals*.pdl”（按字母排序的最后一个画面） 

● 优先级 2： “@PCS7Typicals.pdl” 

● 优先级 3： “@@PCS7Typicals.pdl” 

 

最高优先级的画面将被添加。 

“创建/更新诊断画面”(Create/Update Diagnostic Screens) 功能使用

“@@MaintenanceTypicals”的模板画面。 
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7.2.5 面板 

简介 

面板是专门用于操作员监控的 AS 工艺块中所有元件的图形表示。 面板在 OS 中以独立

的窗口显示，可通过块图标打开。 

例如，以下显示了用于阀控制的块图标及关联面板。 

VALVE： 阀控制 

 

块图标 面板 

 

 

 

 

左键单击块图标可在过程显示中打开阀的面板。 右键单击可打开链接 INTERLOK 块的面

板。 
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INTERLOK： 状态显示锁 

 

块图标 面板 
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7.2.6 在 SIMATIC Manager 中创建块图标 

在 PCS 7 中，默认情况下从工厂层级 (PH, Plant Hierarchy) 获得块图标/画面。 通过在 
SIMATIC Manager 中选中画面属性“从工厂层级获得块图标”(Derive block icons from the 
plant hierarchy) 进行此设置。 

从 PCS 7 V7.0 开始，此设置被预先选中。 
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当编译 OS 项目时，从工厂层级获得/更新块图标。 
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 说明 
块图标的来源通过组态文件进行控制。 用户通常无需调整系统提供的组态文件。 
未调整的组态文件涉及到块图标的以下属性： 

• Higher ProcessControlling 

• ProcessControlling 

• View Tag 

• Return Path 

• StandardTrend 

• Format_InputValue 

• Format_OutputValue 

• Format_xx 

• defaultPos 

• leftPos 

• topPos 
如果更新块图标时涉及到其它属性值，则必须相应地调整组态文件。 
有关其详细说明，请参考 WinCC 信息系统中“组态文件的结构”。 

 

7.2.7 向导 

如果默认情况下块图标不是在 SIMATIC Manager 中从工厂层级 (PH, Plant Hierarchy) 获
得的，则使用用户对象模板时可使用各种向导。 

 

向导名称 “动态向导”(Dynamic Wizard) 中的选项卡 

将面板连接到过程标签  标准动态 (Standard Dynamics) 

更新画面对象 画面功能 (Picture Functions) 

导出画面对象 画面功能 (Picture Functions) 

导入画面对象 画面功能 (Picture Functions) 
 

 

 说明 
有关使用向导的更多信息，请参考手册《过程控制系统 PCS 7 V7.0 操作员站》(Process 
Control System PCS 7 V7.0 Operator Station) 的“使用用户对象模板”部分。 
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7.3 消息系统 

7.3.1 消息类别及消息类型 

简介 

中断和消息被分成不同的消息类别和消息类型。 创建项目时，系统会提供消息类别和消

息类型的默认设置。 这些预定义的消息类别和消息类型可从 AS 组态中选择。 

项目编辑器还会为新项目自动生成过程控制和系统消息。 用户可以在“消息组

态”(Message configuration) 选项卡上抑制各个过程控制消息并分配消息优先级，但此操

作的前提是需要在“常规”(General) 选项卡上禁用增量加载，从而导致必须进行完全下

载。 

 
 

 说明 
在 PCS 7 V7.0 中，最高优先级 16 用于在“高优先级消息”单独列表中显示“紧急消息”。 在
工厂总览中的消息行旁已添加了可用于显示这些消息的按钮。 只要该优先级的消息仍处

于未决状态，此按钮就会闪烁，而与消息是否已确认无关。 
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 说明 
为了防止生成过多的消息，SIMATIC PCS 7 消息概念采用累积消息抑制。 
实例： 具有 8 个通道的 I/O 模块可以为每个通道发出断线信号。 如果该 I/O 模块未与电

源连接，则仅输出这一条消息，而抑制其它与断线相关的消息。 
 

报警、警告及公差消息  

中断、报警及公差消息指示已超出限制值。 这些限制值已在用户组态的 CFC 中进行了定

义。 中断消息类别通常用于紧急停止，也用于其它高优先级的二进制消息。 

此类消息/信号是针对操作员的。 

AS 过程控制消息  

AS 过程控制消息提供有关 I/O 外设及系统中错误的信息，例如，断线、短路、通道错

误、模块故障、访问错误、冗余故障或者辅助电流故障。 如果显示系统生成的消息或信

号，操作员必须立即通知维修团队。 

OS 过程控制消息 

OS 过程控制消息提供有关 OS 系统中错误的信息，例如，数据库访问的错误、OS 服务

器冗余故障、与时间同步相关的错误。 如果显示现场仪器的系统生成消息或信号，操作

员必须立即通知维修团队。 

预防性维护 

预防性维护指示维护人员必须立即查看设备/组件（例如，由于传感器脏污）。 
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过程消息 

过程消息根据用户进行指定。 

操作消息 

操作消息提供有关常规操作期间工厂状态的信息（例如，“到达了温度设定

值”(Temperature setpoint reached)）。 

操作员提示 

操作员提示是顺序控制系统或堆垛系统生成的消息，提示操作员执行某些任务。 

操作员消息  

操作员消息指示操作员已手动执行了哪些任务（例如，“用户 xy：控制 T4711：W 原来

是：20 DEGC，W 现在是：35 DEGC”(User xy: control T4711: W was: 20 DEGC, W is 
now: 35 DEGC)）。 这些消息也可以是系统生成的消息，指示系统中出现的事件（例

如，“密码错误”(Incorrect password)）。 

状态消息 

状态消息提供有关正常操作期间的系统状态的信息，并且还记录这些状态（例如，“通过

芯片卡注册”(Registration via chip card)）。 
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AS/OS 过程控制消息的消息类型 

“系统”(System) 和“错误”(Error) 消息类型已在 PCS 7 V7.0 中更改为“故障”(Failure) 和“错
误”(Error) 类型。现有项目可通过 OS 项目编辑器在“消息组态”(Message configuration) 
选项卡的“消息类别/消息类型”(Message classes/types) 域中进行更新。 

 

修改默认设置 

以下信息仅涉及依据用户要求被强制修改有关颜色和确认原则的系统默认设置的用户，或

因为 S7 通道 (Protocol Suite) 未使用（例如，TELEPERM M 连接）而必须在报警记录系

统中组态其自身消息的用户，。 

组态消息系统时为每个消息分配消息类别。 执行此操作时，不必为每个消息进行大量设

置；可以针对整个消息类别进行设置。 

在 PCS 7 中，可以定义多达 13 种消息类别。还为每种消息类别指定了一种确认模式。 
又可以在各种消息类别中定义消息类型。 消息的文本和背景颜色由其消息类别和消息类

型指定。 
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在一种消息类别中可以定义多达 16 种消息类型。 消息大致分为系统生成的消息以及包含

工厂状态信息的消息。 下表概述了建议的消息类别和消息类型。 此处的解决方案已经过

调整，以满足化学工业的要求。 

 

消息类别 消息类型 确认 目标组 颜色 

中断 (1) 中断上限 (1) 

中断下限 (2) 

具有单个确认的

新值的信号 
操作员 白/红 

警告 (2) 警告上限 (19) 

警告下限 (20) 

具有单个确认的

新值的信号 
操作员 黑/黄 

公差 (3) 公差上限 (37) 

公差下限 (38) 

无确认的信号 操作员 白/青绿 

AS 过程控制消息 (4) AS 系统 (55) 

I/O 故障 (56) 

具有单个确认的

新值的信号 
操作员（通知

维护人员） 
黄/黑 

OS 过程控制消息 (5) OS 系统 (71) 具有单个确认的

新值的信号 
操作员（通知

维护人员） 
黄/黑 

预防性维护 (6) 维护 (89) 具有单个确认的

新值的信号 
维护人员 黄/黑 

过程消息 (7) 过程信号 (106) 具有单个确认的

新值的信号 
操作员 白/洋红 

操作消息 (8) 过程信号 (122) 无确认的信号 操作员 白/洋红 

操作员提示 (9)  操作员请求 (139) 无确认的信号 操作员 白/蓝 

操作员消息 (10) 操作员消息 (156) 无确认的信号 操作员 白/洋红 

状态消息 (16) 状态 AS (253) 

状态 OS (254) 

无确认的信号 操作员 白/深绿 

括号中的数字是用于定义系统文件中消息类别和消息类型的代码号。 
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7.3.2 消息列表 

简介 

SIMATIC PCS 7 根据消息的状态和类型将消息分类并显示为不同的消息列表。 以下消息

列表以消息行形式实现： 

 

 消息行 在过程总览上方显示最新的未确认消息 

 进入的报警列表 显示所有未确认的消息 

 已确认的报警列表 显示仍为活动状态的所有已确认过程消息 

 离开的报警列表 显示所有标记为“离开”(Outgoing) 但尚未确认的消息 

 过程报警列表 显示所有过程控制消息 

 操作列表 显示所有操作员消息（例如，“控制器设定值设置为 xxx。”(A controller 
setpoint is set to xxx.)） 

 历史列表 显示所有消息（进入、已确认及离开消息） 

 隐藏列表 显示所有激活、手动隐藏及自动隐藏的消息 

 要隐藏的消息列表 显示所有未决时隐藏的消息 
 

 

 说明 
从 PCS 7 V7.0 开始，提供了隐藏消息的列表和要隐藏的消息的列表。 
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中断控件 

消息列表通过中断控件显示，而中断控件可在图形编辑器中进行修改。 

在“图形编辑器”中双击某个中断控件，可打开消息块/列的组态对话框。 

右键单击访问属性对话框，其中“LongTimeArchiveConsistency”属性可以用来组态有关每

台 OS 服务器显示的消息数量的特征。 

 

 

否： 每台 OS 服务器最多可扫描并显示 1,000 条消息。 默认情况下，根据日期/时间执行扫描。 扫
描完所有服务器后，会相应地进行排序并显示消息。 在此情况下，显示时可能存在时间间隙

（对于各服务器）。 

是： 所有 OS 服务器最多可扫描并显示 1,000 条消息。 该设置始终确保所有服务器中的消息使用同

一时间序列。 显示的数据量明显少于第一种情况。 
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7.3.3 确认概念 

消息源状态（过程值 0/1）和消息的确认状态（未确认/已确认）有所不同。 二者组合起

来指定消息状态。 

消息状态 
对于一条消息，根据确认方式的不同，可识别多达四种状态： 

● 进入 

● 进入、已确认 

● 进入、离开、未确认 

● 进入、离开、已确认 

当前消息状态由以下属性指示： 

● 元素的颜色和闪烁显示 

● 文本元素中的纯文本 

● 消息行中的时间条目 

在报警记录区的“确认”(Acknowledgment) 对话框中组态该消息类别的消息确认原则及通

过中央信号发送设备确认消息。 
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确认原则选项 

消息确认状态有八种不同的选择： 

● 无需确认的单个消息 

● 需要进入确认的单个消息 

● 需要双重确认的单个消息 

● 需要单一确认的初始值消息 

● 需要单一确认的新值消息 

● 需要双重确认的新值消息 

● 需要确认的无“离开”状态消息 

● 无需确认的无“离开”状态消息 

 

选项 说明 

进入确认 激活需要进入确认的单一消息的复选框。 该消息类别的进入消息必须为确认的。 
消息在被确认前保持排队状态。 

离开确认 激活需要双重确认的单个消息的复选框。 该消息类别的离开消息必须为确认的。 

闪烁 激活需要单一或双重确认的新值消息的复选框。 该消息类别的消息在消息窗口中显

示时会闪烁。 为了使消息块在运行期间闪烁，必须在相应消息块属性中激活闪烁。

仅初始值 激活需要单个确认的初始值消息的复选框。 只有该消息类别的第一个消息在消息窗

口中显示时会闪烁。 必须激活“闪烁”(Flashing On) 复选框。 

无“离开”状态的消息 激活需要或无需确认的无“离开”状态消息的复选框。 激活此选项时，消息不会具有

“离开”状态。 如果只识别出消息的“进入”状态，则该消息不会进入消息窗口，而只

是将其归档。  

分配给唯一用户的注

释 
如果此复选框被激活，则消息窗口内的注释会分配给已登录的用户。 该用户必须在

“用户名”系统块中注册。 如果未输入注释，则任何用户都可输入第一条注释。 当设

置了第一条注释后，所有其它用户可以只读访问该注释。 

进入消息的注释始终

位于消息列表内 
如果激活此复选框，则进入消息的注释会始终显示在具有动态部分“@100%@”、
“@101%@”、“@102%@”和“@103%@”的用户文本块中。 然后，根据消息列表中

消息的状态进行显示。  
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7.3.4 中断管理 

消息处理选项 

以下方法可用于以更直观的方式显示消息传递或减少过程模式中的消息传递量： 

● 根据消息属性（例如，日期、时间、消息类别、消息文本；自 PCS 7 V6.1 起适用）

过滤中断 

● 禁用消息（自 PCS 7 V6.1 起适用） 

通过 OS 操作禁用单个过程标签或层级的子区域。 在 PCS 7 中，这是从消息源进行

确认，与 AS 中块内的确认方式完全相同。 然而，使用此消息抑制类型确实意味着不

会输出更多事件，并且相关信号更改不会保存到消息归档内。 

● 智能中断隐藏（从 PCS 7 V7.0 开始） 

此功能可以根据定义的设备状态隐藏中断，以便减少过程模式中的消息传递量。 该方

法的优点是隐藏的消息仍被归档。 此过程基于将消息汇集到一起，根据

“STATEREP”CFC 块，这些消息随后分配给要定义的设备状态。 消息也可通过手动

方式隐藏。 

通过“隐藏消息的列表”(List of hidden messages) 和“要隐藏消息的列表”(List of 
messages to hide) 消息页面可以显示隐藏的消息。 

  说明 
有关组态智能中断隐藏以及智能中断隐藏的操作员监控方面的所有信息，请参考 PCS 
7 DVD 上的文档“PCS 7 V70 in-practice Alarmhiding.pdf”。 
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7.3.5 组显示 

可使用组显示在各个级别跟踪来自过程画面的特定消息。 总览区构成最高级别。 在此总

览中，操作员可以通过组显示查看每个区域的消息。 

 

消息仅在相关区域中有效。 区域的组显示在局部级别上通过逻辑 OR 运算相关联，并包

含所有较低层级。 

只需单击鼠标就可从组显示（新近接收时会有闪烁的消息）转到画面树。 该功能可以继

续向下转到过程画面，可在其中唯一地分配消息。 如果消息同时出现在两个过程画面中

且这些画面为“OR”运算关系，则该功能会转到组显示集合的第一个过程画面。 

组显示可包含以下信息： 

 

A 闪烁中断信号 （下红上白） 

W 闪烁警告 （下黄上黑） 

T 误差  （下蓝上白，不闪烁） 

S 闪烁错误消息 （下黑上黄） 

O 操作员提示 （下蓝上白，不闪烁） 

X 区域中消息锁定激活 （下灰上白） 
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在 OS 项目编辑器中“消息显示”(Message display) 选项卡的“组显示层级”(Group display 
hierarchy) 域中，已针对 OS 激活了该功能。 
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7.3.6 有声中断信号 

过程故障和错误可通过声音信号进行指示，也可输出在消息列表中。 通过信号模块或有

源音箱（通过计算机声卡输出多媒体 (WAVE) 文件）发出该信号。 

一旦创建了相应的内部变量（报警器组），WinCC 项目管理器中的“报警器”(Horn) 编辑

器就会为不同声音信号提供多种选项，以根据消息类别、区域和优先级触发这些声音信

号。 
 

 说明 
有关信号模块功能和安装的信息，请参见手册《过程控制系统 PCS 7；WinCC 基本过程

控制》(Process Control System PCS 7; WinCC Basic Process Control)。 
从 PCS 7 V7.0 开始，已为“报警器”(Horn) 编辑器中的报警器多重确认选项添加了“在后续

组中进行多重确认”(Multiple acknowledgment in the following group) 功能。 建议仅在 
PCS 7 V7.0 中使用新增的多重确认功能。 

 

7.3.7 时间戳 

消息在 PCS 7 中的不同区域及各种位置生成。因而，消息的来源会影响其时间戳。 

无论其来源是什么，所有消息均以相同的方式归档和显示。 AS 消息和 I/O 消息通过工厂

总线分别转发到 OS 服务器。它们已包含相应的时间戳。 OS 服务器按正确的顺序排列所

有消息。 

要确保始终提供正确的时间戳，必须在 PCS 7 项目的所有组件间组态时间同步。 

 

起源 消息文本的组态 时间戳起源位置 PCS 7 中的含义 

操作员站 (OS, Operator 
station) 

在 OS“报警记录”中 在 OS 中 OS 系统消息  

自动化系统 (AS, 
Automation System) 

在功能块（例如，

CTRL_PID 或 
MEAS_MON）的实例中

在 AS 中 来自 SIMATIC 站的过程消息

和 AS 系统消息 

分布式 I/O（ET 200M、

ET 200iSP、
SimcodePro） 

在功能块 IM_DRV 的实

例中 
在 ET 200M 中，通

过 IM 153-2 
工厂出现故障时，选定的初始

值采集事件（10 ms 精度） 
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7.4 归档 

7.4.1 简介 

备份过程值和消息 

在 PCS 7 工厂中，可归档在过程模式下生成的各种类型的数据。 该数据包括过程值（模

拟值和二进制值）和消息。 

PCS 7 提供了为相应标记的过程值自动创建归档变量的选项。 为此，必须在 SIMATIC 
Manager 中使用“归档”(Archive) 属性将这些过程值标记为与归档相关。 只能为专用于操

作员监控的块 I/O 设置此属性。 可用标签“归档”(Archiving) 和“长期归档”(Long-term 
archiving) 指定是否在使用中央归档服务器 (CAS, Central Archive Server) 时也应长期保

存过程值。 如果选择了“创建归档”(Create archives) 选项，那么执行“编译 OS”(Compile 
OS) 功能时 PCS 7 会自动创建标记的归档变量。 

在完成此步骤后接下来的一个明确画面中（例如，在 SIMATIC Manager 过程对象视图

中），可根据过程标签的实际类型更改记录和归档时间。 

为了显示，可将各个过程标签大致分为四类： 

● 温度测量 (CT) 10 s 至 20 s 

● 液位测量 (CL) 5 s 至 10 s 

● 压力测量 (CP) 3 s 至 5 s 

● 流量测量 (CF) 0.5 s 至 3 s 

根据组件测量范围，其值可能与此处给出的实例值不同。 

默认情况下，归档是在本地 OS 服务器上执行的。 PCS 7 系统会区分必须在小于一分钟

的间隔内归档的归档变量（快速变量记录）与那些必须在大于一分钟的间隔内归档的归档

变量（慢速变量记录），其中，一分钟为默认设置。 系统在在线模式下将这些变量相应

地分配给两个独立的归档数据库。 如果这些归档值在可组态的“过程值归档”或系统归档中

混合到一起，将不会影响将这些值分配给不同数据库的过程。 
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下图显示了归档的结构，其设计为循环日志且使用了单个段。 如果某段已满，则直接为

其创建备份。 为此，段的副本会传送到换出位置，而您必须定义换出位置。 此过程在使

用中央归档服务器 (CAS, Central Archive Server) 或 StoragePlus 时尤为重要。 

 

与快速变量记录及慢速变量记录（从 PCS 7 V7.0 开始）关联的归档值以压缩状态保存在

数据库中，但这不会降低数据的质量。 
可达到的压缩系数取决于各种因素，尤其是归档值能否在采集测量值期间通过足够大的滞

后设置进行合并。 
压缩可以确保值的所需空间减少一半。 结果是通常每个测量值约为 6 个字节，但有时每

个测量值可高达 16 个字节。 
具有最多关联值和注释的消息需要 4 KB。一条消息所需空间的最小值为 172 个字节。 
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归档设置 

系统通常提供两个标准，用于指定单个段的归档大小和循环日志的总大小： 

● 时间段的定义 

● 以字节计的实际大小 

如果超出这两个标准的其中之一，将导致单个段切换至下一段，或覆盖整个循环日志的第

一段。 

由于归档可用的总硬盘容量是确定的，因此对于整个循环日志来说，只有字节方式的指定

标准与之相关。 

针对全部三个归档数据库（快速变量记录、慢速变量记录和报警记录）进行的指定必须符

合标准，并且不能超过可用的硬盘容量。 

实际上，可以定义要用于变量记录的时间段，然后粗略计算关联的存储器要求。 经验表

明，如果使用了中央归档服务器 (CAS, Central Archive Server)，则只需在 OS 服务器上

创建时间范围即可，其中包括标准操作员为进行过程控制访问系统所需的时间段（几天/
周/月）。 

7.4.2 快速变量记录和慢速变量记录的归档组态 

计算 

针对快速变量记录计算在指定时间段 y 月内所有段的存储器要求： 

要执行此计算，需要了解平均每秒钟保存多少个归档值。 您可以在 SIMATIC Manager 过
程对象视图中直观地查看该信息，在此视图中也可读入由 OS 创建的过程值归档。 

对于 x 字节，通常按如下方式计算存储器要求： 
归档值个数/秒 * x 字节 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * y 月 

指定为几天或几周时通常用于单个段。 速度快于一天的段更改不可使用，因为这会使 OS 
服务启动时连接到 MS SQL 数据库的段数量过大，从而削弱性能。 

 

 说明 
通常，总共可生成最多 200 个单个段（对于快速/慢速变量记录和报警记录归档数据

库）。 
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也可以使用以上提供的定义计算以字节计的单个段的大小。 这不是决定性标准，但有必

要进行检查。 如果换出到 CAS，则单个段必须不大于 CAS 中的单个段，而这又由此处

所选的备份介质决定（例如，CD/DVD）。 

（更多信息，请参见 中央归档服务器 (CAS, Central archive server)  (页 240)部分。） 

实例 

您计划使用 2 个月左右的时间段： 已计算出快速变量记录的平均值为 750 归档值/秒。 

● 所有段的最大大小按如下方式计算： 

– 如果每个测量值为 16 个字节，则存储器要求为： 
约 60 GB 
（750 归档值/秒 * 16 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * 2 月） 

– 如果每个测量值为 6 个字节，则存储器要求为： 
约 22 GB 
（750 归档值/秒 * 6 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * 2 月） 

在我们的实例中，选择了 30 GB。 

● 下面计算了每天单个段的大小： 

– 如果每个测量值为 16 个字节，则存储器要求为： 
约 1 GB 
（750 归档值/秒 * 16 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 1 天） 

– 如果每个测量值为 6 个字节，则存储器要求为： 
约 370 MB 
（750 归档值/秒 * 6 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 1 天） 
在我们的实例中，选择了 600 MB。 

  说明 
如果使用了 CAS，出于性能考虑，建议将单个段的最大大小设置为 700 MB。 
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然后，必须在“变量记录”(TagLogging) 编辑器的“快速变量记录”(TagLogging Fast) 组态中

进行以下相应设置： 

 

对“慢速变量记录”进行完全相同的步骤。 已计算出慢速变量记录的平均值为 100 归档值/
秒。 

● 所有段的最大大小按如下方式计算： 

– 如果每个测量值为 16 个字节，则存储器要求为： 
约 8 GB 
（100 归档值/秒 * 16 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * 2 月） 

– 如果每个测量值为 6 个字节，则存储器要求为： 
约 3 GB 
（100 归档值/秒 * 6 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * 2 月） 

在我们的实例中，选择了 5 GB。 
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● 下面计算了每天单个段的大小： 

– 其中，假定测量值 16 个字节，则存储器要求为： 
约 130 MB 
（100 归档值/秒 * 16 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 1 天） 

– 如果每个测量值为 6 个字节，则存储器要求为： 
约 50 MB 
（100 归档值/秒 * 6 字节/值 * 60 秒/分 * 60 分/时 * 24 时/天 * 1 天） 
在我们的实例中，选择了 100 MB。 

  说明 
如果使用了 CAS，出于性能考虑，建议将单个段的最大大小设置为 700 MB。 

 

然后，必须在“变量记录”(TagLogging) 编辑器的“慢速变量记录”(TagLogging Slow) 组态

中进行以下相应设置： 
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7.4.3 报警记录的归档组态 

计算 

与变量记录不同，消息以事件形式出现，且必须做出一些假定，例如，连续的消息平均

量。 根据所涉及的工艺/行业，这些假定可能有很大区别。 

但实际上也可以用另一种方式操作，方法是计算变量记录要求，然后将未使用的可用硬盘

存储器空间添加给报警记录数据库。 这将会成为所有段最大大小的指定标准。 

存储器要求通常按如下方式计算： 

消息数/秒 * 4 千字节/消息 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * y 月 

实例 

假定工厂的事件数为 1 消息/秒。 

● 所有段的最大大小按如下方式计算： 
约 20 GB 
（1 消息/秒 * 4,000 字节/消息 * 60 秒/分 * 60 分/时 * 24 时/天 * 31 天/月 * 2 月） 

● 下面计算了每天单个段的大小： 
约 330 MB 
（1 消息/秒 * 4,000 字节/消息 * 60 秒/分 * 60 分/时 * 24 时/天 * 1 天） 
特意将此限制值设置得较高，以便即使出现消息爆发时仍然可以实现按日换出。 在我

们的实例中，选择了 700 MB。 

  说明 
通常，总共可生成最多 200 个单个段（对于快速/慢速变量记录和报警记录归档数据

库）。 
如果使用了 CAS，出于性能考虑，建议所选单个段的最大大小应为 700 MB。 

 



 组态 OS 功能 
 7.4 归档 

提纲 A 部分 - 组态准则 
操作手册, 09/2009, A5E02122388-01 239 

然后，必须在“报警记录”(AlarmLogging) 编辑器中进行以下设置： 

 

因此，在我们的实例中，硬盘不仅要满足变量记录存储器要求，还要提供 OS 服务器上用

于归档的另外 60 GB 空间（总的“所有段最大大小”）。 
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7.4.4 中央归档服务器 (CAS, Central archive server) 

简介 

中央归档服务器 (CAS, Central Archive Server) 用于进行长期归档： 

● OS 归档数据（过程值和消息） 

● OS 日志 

● SIMATIC BATCH 批生产数据 

从 OS 归档换出的数据在中央数据库中由 CAS 管理。 

使用 CAS 的工厂组态 

 
 

 说明 
必须为 CAS 激活附加的 Microsoft 服务器实用程序及安装 Microsoft 组件；更多相关信

息，请参见手册《过程控制系统 PCS 7 PC 组态和授权》(Process Control System PCS 
7 PC Configuration and Authorization)： 
(http://support.automation.siemens.com/WW/view/en/15236125) 

 

http://support.automation.siemens.com/WW/view/en/15236125
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工作原理 

相关 OS 服务器将已完成归档段副本传送到已启用的 CAS 输入路径（共享）。 从 
SIMATIC BATCH 传送批生产日志由“批生产控制中心”进行控制。 

接收到的数据段保存在 CAS 的数据库中。 CAS 循环日志具有与 OS 服务器循环日志相

同的结构。 应组态这些循环日志的段大小，以便可以将其换出到长期存储介质中。 

 

OS 客户机可以访问保存在 CAS 中的过程值和消息。 要实现此目标，必须将 CAS 服务

器数据分配给该 OS 客户机。 

如果所需的选定时间范围的数据在 CAS 循环日志中也不再可用，则必须插入相应长期存

储器介质并再次将其数据链接到 CAS 数据库。 这通过 StoragePlus 管理控制台在 CAS 
上执行（请参见 StoragePlus (页 250)）。 

已保存的 CAS 归档数据可通过 StoragePlus Web Viewer 显示，也可通过 Internet 
Explorer 在每台已联网的 PC 上显示。 

 

 说明 
来自 CAS 归档的消息在 PCS 7 V6.1 中不可显示在 OS 客户机上。 
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下图说明了 CAS 归档数据库与前面部分列出的 OS 服务器相比如何进行组织。 

 

批生产日志直接通过 BATCH 控制中心 (BCC, Batch Control Center) 传送到 CAS 已启用

的输入路径“ArchiveDir”。 从 PCS 7 V7.0 开始，这可通过 PDF 文件以及常见的 XML 文
件完成。 

用户必须激活预备脚本，才能传送 OS 客户机项目的 PRT_OUT 文件夹内生成的电子 OS 
日志。 

这通过周期性触发（例如，每 10 分钟）的全局操作来调用 OS 客户机上

“StoragePlus_Exports”标准脚本来实现。 
 

 说明 
在 PCS 7 中，通常只有一台 OS 客户机创建日志，这些日志将以电子方式换出到 CAS。

 

CAS 或 StoragePlus 的目标路径 (DestPath) 如下： 
“\\\\<TargetComputerName>\\ArchiveDir” 
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用于导出 OS 日志的用户脚本 

 

定期检查以查看 OS 客户机项目的 PRT_OUT 文件夹内的日志是否已输出。 传送找到的 
*.emf 文件并随后将其从 OS 项目删除。 

对于冗余 CAS，冗余会处理 SIMATIC BATCH 批生产日志的同步。 

对于 OS 日志，则使用“StoragePlus_ExportsEx”标准脚本并将这两个路径均传送到冗余

的 CAS 计算机。 

许可 

如果在项目中使用了 CAS，则现在在此中央位置而非在 OS 服务器本身进行变量记录归

档变量许可。 

然后，各个 OS 服务器从 CAS 远程获取所需归档许可的相应编号。 

ID（“归档”或“长期归档”）指示在哪里使用归档变量就在哪里计数归档变量。 这意味着在 
OS 服务器上不计数专用于换出至 CAS 且具有 ID“长期归档”的归档变量。 
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7.4.5 CAS 组态 

步骤 
 

 说明 
以下说明与 PCS 7 V7.0 相关。 
在 PCS 7 V6.1 中，具有自动备份功能的循环日志概念实现起来很困难。 但是，基本步骤

仍然相同。 
相关信息请参见 PCS 7 V6.1 的手册《过程控制系统 PCS 7；操作员站》(Process 
Control System PCS 7 Operator Station)。 

 

1. 在 SIMATIC Manager 中，在子项目“CAS_1”中，从快捷菜单选择“插入 > 站 > 
SIMATIC PC 站”(Insert > Station > SIMATIC PC station)，并在 HW Config 中打开该

站。 

2. 从“PCS 7 V7.0”目录中插入“WinCC CAS 应用程序”(WinCC CAS Application)。 
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3. 保存并退出 HW Config。 

  说明 
只有从 PCS 7 V7.0 SP1 开始，才能冗余组态 CAS，即组态“WinCC CAS 应用程序

（备用）”(WinCC CAS Appl. (stby))。 

4. 在新创建的 OS 项目的属性对话框中，输入归档服务器的符号计算机名称及其目标路

径。 

  说明 
符号计算机名称用于标识数据包。 请始终在最开始时就在此分配唯一的、有意义的名

称。 对于 OS 服务器项目也应当如此。 
CAS 使用数据包的名称从内部标识提供归档数据的 OS 服务器。 如果随后更改了数据

包名称，则无法再访问已保存的归档数据。 

 

  说明 
在多项目中只能使用一个 CAS（简单或冗余组态）。 
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5. 在“CAS - 中央归档服务器选项”(CAS – Options for the Central Archive Server) 选项卡

上组态 CAS 布局。 
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存储器容量划分 

根据所有 OS 服务器上的快速变量记录、慢速变量记录和报警记录以及所生成的全部日志

所需的空间，来划分中央归档服务器上实际可用的存储器容量。 

由于 CAS 几乎原封不动地接受这些归档数据，所以可以将相应的归档大小连同可用于所

有段的近似关联期作为一个相关条目来计算： 

● 快速变量记录和慢速变量记录（按 快速变量记录和慢速变量记录的归档组态 (页 234)
部分所述计算）。 
但此处请注意，将仅使用显示“长期归档”ID 描述的归档变量数。 PCS 7 的默认设置是

认为 CAS 仅过滤需要长期存储的归档变量。 

● 报警记录（按 报警记录的归档组态 (页 238)部分所述计算） 

● 报表，生成的原始文件大小 

管理单个段的规则 

根据所用备份介质的大小来决定是否将单个段的大小指定为一个相关条目。 因此，必须

将单个段保留的时段设置为足够高的值，以确保不会超过该值。 

以 CD 作为备份介质为例，大小选择 650 MB。 
但是，对于其它介质，如果选择时段时非常关注性能问题，并且操作员因过程控制需要不

断访问 CAS 归档数据，则 1 GB 的值应该可以满足。 

例如，如果通常只是为了评估历史数据而访问 CAS，则可以指定 DVD 的总存储容量。 
如果可用硬盘存储容量非常大，同样更适合采用后面的设置，否则必须将太多的单个段连

接到 SQL 数据库。 

应遵守的规则： 

● 用于归档数据库（快速/慢速变量记录、报警记录和报表）的单个段总数必须小于 
200，此规定也适用于 CAS。 

● 此外，由 OS 服务器传送出的单个段不能大于 CAS 中与之关联的单个段。 
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WinCC 项目管理器中的设置 

1. 在 WinCC 项目管理器中打开 CAS 项目。 

2. 从头到尾运行一次 OS 项目编辑器，以在“消息组态”(Message configuration) 选项卡上

生成 CAS 过程控制消息。 

这些消息保存在 CAS 数据库中，随后可在 OS 客户机上显示（在 OS 客户机中断控

制区域中的默认设置为“所有服务器”(All servers)）。  

 

3. 打开“时间同步”(Time Synchronization) 编辑器，将 CAS 集成到工厂的现有时间同步

机制中。 

4. 如果 CAS 在冗余组态中运行，则需要激活“冗余”(Redundancy)。 

在线更新时会使用与 OS 服务器相同的算法。 但是，由于 CAS 没有过程连接，所以

在过程链接失败或客户机切换后将禁用更新选项。 首次下载之后，必须就有关冗余监

视方面的问题，检查直接下载归档以及保存归档的目标计算机上的冗余设置（如通过 
COM 端口和/或以太网接口进行连接的连接电缆）。 

5. 关闭 WinCC 项目管理器，不对启动列表（图形运行系统保持禁用）或任何其它组态设

置进行任何更改。 
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SIMATIC Manager 中的最终设置 

1. 现在，需要使用 SIMATIC Manager 生成 CAS 的服务器数据并分配给需要访问 CAS 
数据的所有 OS 客户机。 

2. 如果还未选择，则在 OS 服务器项目的属性对话框中选中“传送到中央归档服务

器”(Transfer to central archive server) 选项。 

这可确保在执行下一次下载到目标计算机时，在 CAS 中自动输入换出位置；如果适

用于冗余 CAS，则是在快速/慢速变量记录和报警记录组态中自动输入换出位置。 

  说明 
如果使用 StoragePlus，则必须手动执行此步骤。 

 



组态 OS 功能  
7.4 归档 

 提纲 A 部分 - 组态准则 
250 操作手册, 09/2009, A5E02122388-01 

7.4.6 StoragePlus 

使用 StoragePlus/与 CAS 比较 

● StoragePlus 用于独立的计算机，不能冗余运行。 只能在 StoragePlus 计算机上本地

运行 StoragePlus 和恢复视图。 

● 不能使用 Internet Explorer 从其它计算机访问 StoragePlus，也不能通过 OS 系统恢

复数据。 

● 在与 CAS 相关的部分介绍的数据库结构也是 StoragePlus 的一部分。 

● 在 StoragePlus 管理控制台的“公共”(Common) 区域组态数据库设计。 在组态方面，

与在 CAS 相关部分中介绍的 SIMATIC Manager 菜单的“CAS 选项”(CAS Options) 选
项卡相对应。 
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StoragePlus 中的数据库段概述 

单击管理控制台的“归档”(Archive) 区域中的“目录”(Catalog) 按钮，可从总体上查看目前连

接到 StoragePlus 数据库的归档类型段。 

 

可根据需要使用“连接”(Attach) 按钮将已换出的备份自动连接到 StoragePlus 数据库，使

用“分离”(Detach) 按钮从 StoragePlus 数据库分离。 
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Web Viewer 

StoragePlus Web Viewer 允许通过视图访问已保存的 CAS 数据。 

 

可以使用 StoragePlus View Editor 预先永久组态视图，也可以在访问 CAS 数据时自由编

辑视图。 
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7.5 PCS 7 Web 选件 

要求 

● 可在工厂中使用服务器/客户机结构实现 Web 解决方案，也可以在 OS 单工作站上实

现 Web 解决方案。 

● 仅 Windows 2003 Server 可用作装有 PCS 7 V7.0 的 Web 服务器的操作系统。 

● 借助 Web 解决方案，用户如今可以使用 Web 客户机访问工厂/工厂区仍使用 
PCS 7 V7.0 以前版本的 Web 服务器。但是必须在 Web 客户机上安装最新版本。 这
样，装有 PCS 7 V7.0 SP1 的 Web 客户机就可以访问装有不同版本的 Web 服务器

（PCS 7 V6.1 SP1 或更高版本），不同版本提供的功能也不同。 

● 为了通过面板执行过程操作，必须从 SIMATIC Manager 工厂层级获得 OS 层级（画

面树）。 但是至少 OS 和 AS 中使用的区域名称必须匹配。 

OS 服务器负载 

在工厂组态中混合使用了 OS 客户机和 Web 客户机的情况下，考虑到 OS 服务器的负

载，可使用以下公式大致计算允许的客户机数量：  

OS 客户机数量 * 2 + Web 客户机数量 * 1 <= 60 

组态注意事项 

● 如果服务器/客户机结构已存在，同时用作 OS 客户机的 Web 服务器必须从头至尾运

行至少两次，才能发布画面、脚本和状态显示（对于 Web 服务器是服务器数据包数

量 + 1）。 

● 在用户管理器中，必须从 OS 客户机选择启动画面“@Screen.pd_”，不能从 OS 服务

器选择具有相应服务器前缀的画面。 

● 可以在用户管理器中为不同的登录配置文件分配已在 OS 系统中组态的各种语言。 
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● 有新消息时也可以在 Web 客户机上发出声音信号。 更多相关信息，请参见组态实例

“PCS 7 Web 客户机的声音中断信号”。 
(http://support.automation.siemens.com/WW/view/en/29088810) 

  说明 
系统介绍： 

• 有关如何使用 Web 解决方案的详细说明，请参见手册《PCS 7 OS Web 选件》

(PCS 7 OS Web Option)。 
(http://support.automation.siemens.com/WW/view/en/27002475) 

• 就这点而言，我们还特别希望您参考手册 
《PCS 7 安全性概述；建议和注意事项》(PCS 7 Security Concept 
Recommendations and Notes)（适用于 PCS 7 V6.1）： 
(http://support.automation.siemens.com/WW/view/en/22229786) 
和《PCS 7 和 WinCC 安全性概念 – 基本文档》(Security Concept PCS 7 and 
WinCC – Basic Document)（适用于 PCS 7 V7.0）： 
(http://support.automation.siemens.com/WW/view/en/26462131) 

http://support.automation.siemens.com/WW/view/en/29088810
http://support.automation.siemens.com/WW/view/en/27002475
http://support.automation.siemens.com/WW/view/en/22229786
http://support.automation.siemens.com/WW/view/en/26462131
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7.6 用户管理 

7.6.1 用户管理器 

功能范围 

“用户管理器”(User Administrator) 编辑器用于建立用户管理。 

 

该编辑器用于为用户分配对组态系统中各个编辑器以及对过程模式下的各个功能的访问权

限，以及用于监视这些权限。 为此，需要在用户管理器中为 OS 功能分配访问权限（也

称为授权）。 这些授权可以分配给单个用户，也可以分配给用户组，还可以在过程模式

期间分配。 
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用户管理器的其它特性： 

● 组态“变量登录”(variable logon) 功能，用户可用于登录 OS 客户机。 此功能可通过变

量值实现，例如，通过钥匙开关设置该变量值。 

● 一定时间过后自动注销用户 

● 用户通过智能卡登录 

可以在以下两个用户管理选项之间选择： 

● WinCC Logon 

● SIMATIC Logon 

WinCC Logon 和 SIMATIC Logon 选型指南  

 

条件 SIMATIC Logon WinCC Logon 

在过程模式下，操作员必须登录到 PC 上的多个应用程序（OS、
SIMATIC BATCH、路径控制、Automation License Manager、
SIMATIC Manager）。 

非常支持 反对 

使用一个具有多个 OS 客户机的客户机/服务器项目。 支持 反对 

使用单工作站，或者仅有少数几个 OS 客户机的客户机/服务器项

目。 OS 客户机是被参考 OS 客户机。 
支持 支持 

需要一个用户/用户组的集中管理环境。 非常支持 反对 

不需要对用户/用户组进行集中管理。 支持 支持 

所有 OS 客户机都是被参考 OS 客户机。 支持 支持 

将会记录登录和注销步骤。 支持 反对 

SIMATIC Logon V1.4 随 PCS 7 V7.0 SP1 一起提供。 “合同授权”用于 SIMATIC Logon， 

表示不会对 PCS 7 中的 SIMATIC Logon 收取额外授权费用。因此，我们通常建议使用 
SIMATIC Logon，因为此应用程序比 WinCC Logon 功能更强大，而且不需要支付任何额

外费用。 
 

 说明 
SIMATIC Logon 和用户管理器向智能卡写入不同的用户信息： SIMATIC Logon 还需要知

道将在哪台计算机或域控制器上检查用户密码。 
因此，SIMATIC Logon 和 WinCC Logon 智能卡彼此之间不兼容。 
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7.6.2 WinCC Logon 

操作方法 

当用户使用用户名和密码登录系统时，用户管理器会检查是否已在 OS 中创建该用户。 
如果还未创建该用户，则在 OS 中不会为其分配任何权限；若输入的密码不正确，结果也

是如此。  

这意味着，该用户不能在过程模式下监视或控制过程。 

如果正确登录的用户调用受权限保护的 OS 功能，则用户管理器将检查相关用户授权是否

允许访问此功能。 如果没有适当的授权，则用户管理器拒绝用户访问请求的功能。 

在“用户管理器”(User Administrator) 编辑器中管理用户组、用户和密码。 必须分别在每

个 OS 客户机上创建用户组、用户和密码。 为了避免不得不在 OS 客户机中重复进行创

建工作，可以使用被参考 OS 客户机。 但是，对于被参考 OS 客户机来说，每个客户机

的用户管理组态必须完全相同。 
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组态用户管理 

以下实例说明如何使用 WinCC Logon 组态用户管理系统： 

1. 使用 SIMATIC Manager 打开 OS 客户机项目，然后从中打开“用户管理器”(User 
Administrator) 编辑器。 

2. 选择“用户 > 创建组”(User > Create Group) 菜单命令，以创建新“操作员”(Operators) 
用户组并分配相关授权。 

3. 在“操作员”(Operators) 组中创建用户名为“Operator1”的新用户，并为该用户分配密

码。 
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7.6.3 SIMATIC Logon 

简介 

SIMATIC Logon 是一个基于 Windows 2000/XP 和 Windows Server 2003 的集中用户管

理系统，可实现各 SIMATIC PCS 7 系统组件的访问控制要求。 

下列 PCS 7 系统组件使用 SIMATIC Logon： 

● PCS 7 OS 

● SIMATIC BATCH 

● SIMATIC 路径控制 

● SIMATIC Manager 

● Automation License Manager 

SIMATIC Logon 由下列组件构成： 

 

软件组件 应用领域 使用该软件组件的 PCS 7 
系统组件 

SIMATIC Logon Service 对 SIMATIC 应用程序的集中访问保护 使用 SIMATIC Logon 的
所有组件 

SIMATIC Logon 角色管理 对应用程序的角色管理以及将应用程序分配到 
Windows 组，包括权限分配 

SIMATIC BATCH 

SIMATIC Manager 

SIMATIC Logon 事件日志

查看器 
SIMATIC Logon 事件日志浏览器是一个组件，用

于对应用程序的事件进行记录和可视化。 
使用 SIMATIC Logon 的
所有组件 

SIMATIC 电子签名 为过程中的状态变化和过程访问创建电子签名 SIMATIC BATCH 

SIMATIC Logon 开发包 此开发包适合编程人员用于在客户应用程序中集成 
SIMATIC Logon。 

无 
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操作方法 

下图说明了一个使用 SIMATIC Logon 的验证方案。 

 
 

 说明 
如果 SIMATIC Logon 配合一台登录计算机使用，则该登录计算机必须总是可用并且不能

出现超过最大负载的情况；因此，我们不建议使用 ES 作为登录计算机。 
使用 SIMATIC Logon 时，无论您是使用登录计算机还是使用域，都始终可以通过本地计

算机登录。 我们建议您也在本地计算机上创建所有必需的用户和组，以便登录计算机或

域不可用时用户仍可登录到应用程序。 
做到这一点最有效的方法是使用批处理文件来创建所有用户。 
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组态用户管理 

下面的实例说明如何与 SIMATIC Logon 一起组态用户管理系统（必须在 ES 上安装 
SIMATIC Logon）： 

1. 在 ES 上打开 OS 客户机项目。 

2. 打开“用户管理器”(User Administrator) 编辑器。 

3. 激活“SIMATIC Logon”选项。 

 

4. 在“用户管理器”(User Administrator) 编辑器中创建名为“操作员”(Operators) 的用户

组。 

5. 为“操作员”(Operators) 用户组分配相关授权。 

6. 打开 Windows 操作系统的“计算机管理”(Computer Management) 区域。 
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7. 创建名为“操作员”(Operators) 的用户组。 
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8. 例如，在“计算机管理”(Computer Management) 中创建名为“JohnGreen”的新用户，并

将此用户分配到“操作员”(Operators) 用户组。 

 
 

 说明 
在 Windows 操作系统和 OS 用户管理器中，必须以完全相同的方式输入新创建的用户组

的名称。 这些名称区分大小写。 
只需在登录计算机的操作系统中创建用户。 用户通过登录计算机成功登录后，便在 OS 
中为该用户分配授权。  
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7.7 下载 OS 项目 

步骤 

大体上，下载单个 OS 项目、OS 服务器和 OS 客户机的方式基本相同。 下面以 
SERVER1A 为例对此进行了说明。 

1. 在组件视图中，选择要下载的 OS 对象，然后选择“PLC > 下载”(PLC > Download) 菜
单命令。 

  说明 
在 PCS 7 中，这是将 OS 项目下载到目标计算机的唯一可用方法。 明确禁止使用 
WinCC Project Duplicator。 

2. 在下一个对话框中，定义要下载的数据范围。 

首次下载 OS 服务器（本例中为 SERVER1A）时，需要执行完整下载。 下载 OS 服
务器更改时所遵循的步骤在本文档的 在线下载更改 (页 267)部分中介绍。 总是必须完

整下载 OS 客户机。 

 

  说明 
从 PCS 7 V7.0 开始，可以在开始下载过程之前启动 OS 编译。 
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3. 下面的对话框显示下载过程进行到什么程度；此过程必须成功完成。 

 

  说明 
如果 ES 对 CP 1613 没有访问权限，则不能在此进行时间同步设置。 在这种情况下，

下载 OS 项目后，必须在两台服务器 PC 上均进行时间同步设置。 
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4. 从 PCS 7 V7.0 开始，可以下载过程完成后调用服务器和客户机的加载日志。 此日志

会记录下载期间执行的所有操作，以及执行操作的时间和日期。 
在组件视图中，选择 OS，然后选择“显示加载日志...”(Display load log...) 菜单命令。 

 
 

 说明 
组态期间 WinCC 项目中的计算机名称与所有 OS 项目中工程师站的名称相对应。 将 OS 
项目下载到各个 PC 时，该名称自动由相应目标 OS 计算机的名称所取代（请参见加载日

志）。 
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在过程模式下更改项目 8
8.1 在线下载更改 

简介 

在 ES 上插入了新工厂对象/画面并测试了其功能后，必须更新 OS 服务器和 OS 客户

机，以使新功能可用于过程中。 

如果未更改结构，而只能编译 OS 更改，则 OS 服务器可在下载过程中保持运行模式。 
完整下载 OS 时必须停止运行模式。 

只有 OS 服务器能在线下载更改到 OS；OS 客户机会自动更新。 如果更改了客户机项目

（例如，在“用户管理器”(User Administrator) 中更改了权限），则必须明确下载 OS 客户

机。 只能完整下载 OS 客户机。 
 

 说明 
切勿直接更改各 OS 服务器和 OS 客户机站的 OS 项目，因为随后将不能使用“下载更

改”(Download changes) 功能；而是必须执行完整下载。 
所有更改均在 ES 上执行，然后下载到各种 OS 站上。 
OS 服务器的冗余设置和 Web 服务器的设置则不是这样。 

 

要求 

只有在相应的 PC 上激活了运行模式时，才能在线下载更改到 PCS 7 OS。 对于冗余服务

器，两个工作站必须都处于运行模式。 

为了使用在线下载更改功能，整个项目必须已编译过且至少被成功下载过一次。 必须已

将完全相同的项目数据完整下载到冗余 OS 服务器。 

步骤 

借助“编译并下载对象”(Compile and Download Objects) 对话框可阶段性地或自动执行更

新步骤。  
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8.1.1 阶段性编译和下载 

步骤 

1. 请在 CFC 或 SFC 编辑器中编译 S7 程序。 

就 AS 下载更改的能力而言，选择“仅限更改”(Changes only) 或“整个程序”(Entire 
program) 选项并没有什么区别。  

2. 接着，使用“仅限更改”(Changes only) 选项将修改后的 S7 程序下载到处于 RUN-P 状
态的 AS 中。 

3. 使用“仅限更改”(Changes only) 选项编译主站 OS 的 OS 项目。 此设置也将确保自动

更新与 OS 对应的服务器数据。 

4. 将 OS 项目从 ES 下载到服务器。 

由于激活了运行系统，因而“OS 下载”(OS Download) 对话框仅提供“仅限更

改”(Changes only) 选项。  

下载更改到冗余 OS 服务器对时，该功能首先将更改下载到组态的备用 OS。 在完整

执行此过程并单击“确定”(OK) 进行确认后，便会开始下载更改到组态的主站 OS。 不
管这两个 OS 服务器中的哪一个目前组态为主站，都要遵守此顺序。 

将更改下载到 OS 服务器后，还会自动更新 OS 客户机，因为它们再次接收到包含服务器

数据的数据包。 
 

 说明 
上述步骤应迅速执行，以确保从更改 AS 到更改 OS 的期间不会出现数据不一致的问题。

应通知操作员任何未决的更改。 
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8.1.2 中央对话框，“编译并下载对象” 

“编译并下载对象”(Compile and Download Objects) 对话框（执行对话框）可用于相继地

自动更新所有 SIMATIC 站（AS、OS）。 

 

通过“编辑”(Edit) 按钮，可对相关对象分别进行编译更改和下载更改的设置。 这将会调用

阶段性编译和下载 (页 268)部分所述的对话框。 

在启动自动处理过程之前，可以使用“测试”(Test) 检查设置是否一致。 

将更改下载到 OS 服务器后，由于 OS 客户机也会接收到新服务器数据，因此还会更新 
OS 客户机。 
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8.1.3 背景信息 

关于下载更改的重要信息 
 

小心  
切勿直接在 OS 上更改项目，因为随后将无法使用“下载更改”(Download changes) 功
能，从而导致必须执行完整下载。 

 

 说明 
执行“下载更改”(Download changes) 功能时，在 AS 和 OS 数据之间会出现临时的数据不

一致。 因此，在将修改后的数据下载到 OS 之前，应首先将其下载到自动化系统上。 这
可缩短数据不一致的持续时间。 

 

下载更改时自动更新 OS 客户机 

使用“下载更改”(Download changes) 功能时，服务器数据会自动更新。 

一旦下载了更改，OS 客户机便会自动接收到更新的数据，因此不必显式地下载数据。 

如果执行“下载更改”(Download changes) 功能时 OS 客户机不处于运行模式，请按以下步

骤操作： 

1. 将要向 OS 客户机提供数据的所有 OS 服务器切换到运行模式。 

2. 然后启动 OS 客户机。 

这样随后便会更新 OS 客户机上的数据。 

下载更改到冗余 OS 服务器对 

出于数据安全考虑，不会同时对冗余 OS 服务器对执行下载过程。 

将首先下载组态的备用 OS。 此下载过程一旦成功完成，就会下载组态的 OS 主站。 不
管这两个 OS 服务器中的哪一个目前组态为主站，都要遵守此顺序。 

 

 说明 
仅当两个 OS 服务器都处于运行模式，才能对冗余 OS 服务器对执行“下载更

改”(Download changes) 功能。 
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下载单工作站系统的更改 

对于单工作站系统（OS 和 ES 位于同一 PC 站上），不需要单独下载 OS，因为本机上

已经提供了所有数据。在这种情况下，只需运行“编译 OS”(Compile OS) 功能。与“下载更

改”(Download changes) 功能类似，可对单工作站系统运行“编译更改”(Compile changes)
功能，而无需在 OS 上停止过程模式。 

下载具有参考 OS 的单工作站系统的更改 

如果已组态了将作为参考 OS 的操作员站上的更改下载到基本 OS，则必须下载所有操作

员站（基本 OS 和参考 OS）。 
 

 说明 
在对基础 OS 执行更多更改之前，所有参考操作员站必须下载更改。 
如果没有为参考 OS 执行此操作，则必须对此参考 OS 执行完全下载。 
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8.1.3.1 有关数量结构的建议 

由于 OS 服务器上的组态数据不一致，在线下载更改时，应该只组态和传送少量更改（10 
到 30 个过程对象或 500 个更改 — 例如变量、归档变量和消息的总数）。 

在线下载更改不适合于传送大量数据，更确切地说，仅适合用于将单个的过程对象插入项

目。 
 

 说明 
我们建议您分阶段完成大量更改，在工程组态之后将各个分包单独传送到 OS。 
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OS serverOS server StartStart
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8.1.3.2 允许将更改下载到 OS 的操作 

下文概要介绍了可以在何处进行更改，以及随后可以使用“下载更改”(Download changes) 
功能传送哪些更改： 

● 工厂视图中的更改 

● 组件视图中的更改 

● CFC/SFC 图表中的更改 

● 块和块实例的更改 

● WinCC 项目管理器中的更改 
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工厂视图中的项目更改 

可在工厂视图中下载以下更改而不必停止 OS： 

● 将文件夹插入工厂视图 

● 将文件夹重新分配给工厂视图 

● 将文件夹复制到工厂视图 

● 在工厂视图中重命名和删除文件夹，该文件夹是高层级标识 (HID) 的组件 

● 重命名 OS 的画面 

● 随后激活“从工厂层级中获得画面层级”(Derive picture hierarchy from the plant 
hierarchy) 设置 

● 重命名 OS 区域 

● 修改 OS 区域的工厂层级 

● 修改 AS 分配并将更改转发到所有低层级对象 

● 修改 OS 分配并将更改转发到所有低层级对象 

● 重命名、插入、删除和修改 OS 画面 

● 重命名、插入、删除和修改 OS 报表 

组件视图中的项目更改 

可在组件视图中下载以下更改而不必停止 OS： 

● 重命名、插入、重新分配和删除 AS 

● 重命名、插入、重新分配和删除 S7 程序 

● 重命名多项目 

● 重命名、插入和删除“图表”(Charts) 文件夹 

  说明 
删除 AS 或 S7 程序时，在通过执行存储器复位进行完全编译之前，不会删除变量和连

接。 
重命名 S7 程序时，OS/AS 通信将暂时中断，这是因为必须更新数据库中对应的连接

名称： “旧”连接名称将被删除，并注册新名称。 
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CFC/SFC 图表中的更改 

可下载图表中的下列更改而不必停止 OS： 

● 重命名、插入和删除“图表”(Charts) 文件夹 

● 重命名、插入、删除和修改 CFC 图表 

● 重命名、插入、删除和修改 SFC 图表 

块和块实例中的更改 

可下载块和块实例中的以下更改而不必停止 OS： 

● 重命名“源”(Sources) 和“块”(Blocks) 文件夹 

● 插入或删除块 

● 重命名符号表中的块 

● 修改符号表中的块地址 

● 修改块文件夹中的块编号 

● 修改块的监控属性 

● 修改块实例的监控属性 

● 重命名、插入和删除 CFC 图表中的块实例 

● 修改消息文本 

● 修改块类型的块 I/O，例如，添加或删除名称、数据类型或 I/O 

  说明 
对块类型的块 I/O 进行更改时，必须停止 AS。 
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WinCC 项目管理器中的更改 

以下列表仅包含了 WinCC 项目管理器中那些也可在 PCS 7 环境下定义的设置。此处未

列出由 PCS 7 本身进行的任何设置。 可下载对这些设置的下列更改而不必停止 OS： 

● 归档组态（变量记录） 

● 报表组态（报表设计器） 

● 脚本程序（全局脚本） 

● 文本库编辑 

● 用户权限设置 

● 用户归档组态 

● 时间同步设置 

● 设备状态监视设置 

● OS 项目编辑器（取决于设置） 

● 报警器 

● 过程画面和相关脚本的更改 

● SFC 显示属性的更改 

8.1.3.3 需要完整下载和停止 OS 的操作 

在某些情况下，无法选择“下载更改”(Download changes) 功能。 进行以下更改后，不能

再使用“下载更改”(Download changes) 功能： 

● 修改 OS 名称 

● 完全编译 OS 

● 修改指向目标计算机的路径 

● 修改主 OS/备用 OS 分配 

● 修改冗余 OS 服务器的组态 

● 将多工作站系统更改为单工作站系统（通过删除 OS 客户机） 

● 修改 OS 项目属性 

● 修改 OS 中的热键 

● 将服务器数据从新添加的 OS 服务器下载到现有 OS 服务器 
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● 修改中断组态 

● 修改“从工厂层级中获得诊断屏幕画面”(Derive diagnostic screens from the plant 
hierarchy) 设置 

● 修改计算机名称（需要完全重新安装） 

● 修改计算机属性（复位和重启操作系统） 

● 停止/中止将更改下载到 OS 的过程 

● OS 项目编辑器（取决于设置 - 见屏幕截图） 

 
 

 说明 
只有再次下载整个项目之后，“下载更改”(Download changes) 功能才会再次可用。 
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8.2 完整在线下载到冗余 OS 服务器对 

简介 

用户在初始加载或执行过实质性更改后必须要执行完整下载。 在这类情况下，只能编译

整个程序。 

步骤 

要在操作期间下载整个程序且不中断数据归档，必须执行下列步骤： 

1. 编译主站 OS 的项目（完全编译或者仅编译更改）。 

2. 通过禁用 OS 运行系统并退出 WinCC 项目管理器，关闭主站服务器上的 OS 项目。 
冗余 OS 伙伴服务器将变成主站，并且 OS 客户机会切换到该伙伴服务器。 

  说明 
建议此时重启 PC（主服务器）。 
将 OS 项目数据存储在服务器上。 

3. 检查是否需要加载新连接数据。 如果新连接数据可用，则先下载数据，然后再继续操

作。 

4. 现在，可以将整个 OS 项目从 ES 下载到 OS 服务器。 

5. 一直等到出现一条消息说明下载步骤已成功完成，然后才重新激活 OS 服务器运行系

统。 

6. 在加载的服务器上激活 WinCC 运行系统。 激活后，冗余管理器启动，以同步两个冗

余 OS 服务器的数据。 一直等到出现过程控制消息“REDRT:归档更新完

成”(REDRT:Archive update complete)。 

7. 现在，关闭还未加载的服务器（备用服务器）上的 OS 项目。 已加载的服务器再次变

成“主服务器”。 OS 客户机再次进行切换。 

  说明 
建议此时重启 PC（备用）站。 
将 OS 项目数据存储在服务器上。 

8. 检查是否需要加载新连接数据。 如果新连接数据可用，则先下载数据，然后再继续操

作。 
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9. 现在，将 OS 项目下载到备用 OS。 

10. 如果出现一条消息说明下载步骤已成功完成，表明已完全下载了该项目。 现在，在加

载的服务器上激活 WinCC 运行系统。 激活后，冗余管理器启动，以再次同步数据。 
一直等到出现过程控制消息“REDRT:归档更新完成”(REDRT:Archive update 
complete)。 

 

 说明 
始终必须立即下载到两个伙伴，以恢复冗余系统中组态数据的一致性。 
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集成的资产管理 9
 

使用 PCS 7 诊断和维护功能，可以监视 PCS 7 工厂的各种组件并在过程模式下显示组件

的状态。 此状态由已定义的图标来表示。 

必须组态维护工作站 (MS, Maintenance Station)，才能利用这些诊断和维护功能。 MS 
的基础架构始终是一个提供附加维护功能的 OS。 维护工作站可作为单工作站系统运行或

在服务器/客户机体系结构中运行。 

9.1 组态 

9.1.1 具有维护工作站 (MS) 的单工作站系统 

ES、OS 及 MS 在同一台计算机上。 

 
 

 说明 
在此工厂组态中，OS 必须组态成一个单工作站系统。 在 SIMATIC Manager 中创建项目

时，使用“新建项目”(New Project) PCS 7 向导进行此设置。 
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9.1.2 MS 客户机在 ES 上的多工作站系统 

简介 

MS 客户机直接在主站 ES 上运行。 当前的多项目也存储在此处。 MS 服务器可以安装在

现有 OS 服务器上，也可以安装在单独的计算机上。 MS 服务器可采用冗余组态。 一个

多项目中只有一个 MS 服务器。 多项目中的所有组件均通过此服务器进行监视。 

 

 

① 网络适配器通过 TCP/IP 连接到工厂总线（通过 SNMP 进行监视） 

MS 服务器执行下列基本任务： 

● 提供诊断区域的画面 

● 通过 SNMP 监视网络组件和 PC 站 

视工厂规模而定，MS 服务器应集成在现有 OS 服务器上或单独安装。 我们有如下建议： 

MS 服务器在现有 OS 服务器上： 

● 工厂有 1-2 个 OS 服务器 

● 必须根据授权和性能因素充分考虑了 OS 服务器的规模。 包含一个缓冲区，供将来计

算方面的扩展。 

● 此方案的优点是不需要更多计算机。 

● 可能需要调整授权数量，而不需要购买全新的授权。 
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MS 服务器作为单独的计算机： 

● 工厂配有三个或更多服务器 

● 此方案的优点是可以单独将 MS 服务器明确分配给“诊断区域”，而不是分配给工厂区

域。 

● 例如，加载 MS 服务器时就不会影响工厂区域，而操作员必须始终可以看到工厂区域

以确保透明处理。 

● 由于是单独计算机，因此有很高的灵活性，如在升级工厂方面等 
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9.2 组态提示 
 

 说明 
有关组态以及必须满足的相关要求的详细说明，请参见手册《过程控制系统 PCS 7；操

作员站》(Process Control System PCS 7 Operator Station)： 

• “使用诊断功能”部分（适用于 PCS 7 V6.1） 

• “使用 PCS 7 维护工作站”部分（适用于 PCS 7 V7.0） 
 

在多项目中创建一个独立项目，用于 PC 站的资产管理。 
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多项目（模块驱动程序、HW Config、PDM）中的数据是资产管理的基础。 诊断区域的

组件名称是通过 HW Config 和 PDM 中的组件名称派生而来。 请分配唯一名称，不超过 
14 个字符。 

 

 说明 
激活了诊断功能时，PH 名称将总是源自硬件组件的名称。 

 

 

从 PCS 7 V7.0 开始，硬件组件注释域中的文本会显示在该组件的相应面板的一个附加域

中。 
 

 说明 
在“PCS 7 V70 in-practice ASSET.pdf” 手册的“标识视图中的组件注释”(Component 
comments in the identity view) 部分介绍了一个实例。 该手册位于 PCS 7 V7.0 DVD 上的

\_Manuals\ 文件夹中。 
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9.3 更多信息 
请使用“将 SIMATIC PCS 7 资产管理集成到现有项目中”(Integration of SIMATIC PCS 7 
Asset Management in Existing Projects) 文档，该文档在西门子工业自动化与驱动技术服

务与支持页面上，网址为： 
(http://support.automation.siemens.com/WW/view/en/27833758) 

该文档的优点： 

● 采用图解分步介绍了如何进行组态 

● 详细说明了各项要求 

● 采用图解分步介绍了如何进行 NDIS 组态 

● 说明了如何集成到旧项目中 

还请阅读 PCS 7 自述文件中的“资产管理”部分（例如诊断区域对于 PCS 7 Web 功能无

效）。 

有关 PCS 7 V7.0 的增强功能，请参见“PCS 7 V70 in-practice ASSET.pdf”手册。 该手册

还详细说明了 PCS 7 V6.1 和 PCS 7 V7.0 在资产管理方面的差异。 

从 PCS 7 V7.0 开始，可在资产管理中显示 CPU 的性能负载。在“PCS 7 V70 in-practice 
CPU-RT.pdf” 手册中说明了相关要求和 CPU 的新过载特性。 该手册位于 PCS 7 V7.0 
DVD 上的 \_Manuals\ 文件夹中。 

 

 说明 
在《过程控制系统 PCS 7；OS 过程控制》(Process Control System PCS 7 OS Process 
Control) 手册的“PCS 7 维护工作站 - 工厂维护”部分介绍了诊断区域的操作。 

 

 

http://support.automation.siemens.com/WW/view/en/27833758
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